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ISE Post Processing Software 

This User’s Guide is a task oriented manual which describes how to use the ISE 

software application for processing echo sounder data of the Parametric Echo Sounder 

SES-2000. To use this product effectively, one should be familiar with the following: 

• Microsoft® Windows® Operating System and personal computers 

• Sediment Echo Sounder System SES-2000 

• Underwater Acoustics and Echo Sounding Terminology 

For additional information about personal computers and Windows® read your 

computer manual or visit your local book store. 

Please, read the hard and software manuals for additional information about the 

Parametric Sediment Echo Sounder SES-2000. 

Introduction 

The Sediment Echo Sounder SES-2000 is a sub bottom profiler that is equipped in 

advanced online signal processing capabilities. The first results are presented as a 

picture on the screen or a hardcopy on paper. Often the users want to process the data 

again to get as much information as possible. The system SES-2000 possibility to 

digitize and store the echo sounder data allows further processing. With the software 

package ISE the user has a great tool for different processing tasks, like digitizing 

layers, correcting echo plots with tide data, motion sensor data or GPS data and 

extracting the information to export into compatible formats. The ISE software is fully 

compatible with all recorded data files from the systems SES-2000 smart, SES-2000 

compact, SES-2000 light, SES-2000 standard, SES-2000 medium, SES-2000 ROV, 

SES-2000 deep and SES-2000 quattro. 

ISE User’s Guide 

This user’s guide describes how to use the ISE software in general and tries to show 

solutions for realizing different processing tasks. After a short description of the main 

function it will show in a task orientated way how to use the software effectively. Some 

facts about the document structure: 

• Bold marks subordinated headlines. 

• Italics (black) is used for file and path names. 

• Italics (blue) is used for internal and external links. 

• Keys belonging to the keyboard are enclosed in brackets. If some keys have to be 

pressed at the same time, they are separated by ‘+’ (example: Press 

[Ctrl]+[Alt]+[Del] to open the task manager). 

• The symbol  marks a very useful hint or key fact. 
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ISE Installation 

The ISE software is shipped on a USB memory device or a CD-ROM. It is possible to 

install the software on the SES-2000 acquisition PC as well as on a personal computer 

for processing tasks in the office. Use the Windows® explorer to copy the ISE software 

to the hard drive of the personal computer. Our folder recommendations are: 

- do not use common system folders where you may not have read/write access, 

such as “C:\Windows\” 

- you may install the software under “C:\Program Files\” 

- do not use a folder on a network drive 

- do not use a folder on a removable drive 

- you must use an installation folder with read/write access for the user 

- the data folder must have read/write access for the user 

- ISE will use the shared folder “C:\Windows\Temp” for storing temporary files and it 

is required that the user has read/write access for this folder 

- the default folder for SES-2000 systems with integrated PC hardware is called 

“C:\SES_Applications\” where all Innomar software is stored 

To start the ISE software the program file ISE.EXE needs to be copied from the 

provided disk. There are no additional DLL’s required. Innomar does not provide a 

dedicated setup program for the ISE software. Start the program like every other 

program under the Microsoft® Windows® environment. If desired, a link to the ISE.EXE 

program on the desktop can be created. 

In case of software updates, the updated ISE.EXE needs to be copied to the ISE folder 

by replacing the original file. In order to check if any updates are available, the ISE 

menu item “Help/Check for Update…” will make a connection to our server and 

retrieves the latest ISE version number and release history. An update will not be 

downloaded automatically, but has to be requested from Innomar by e-mail or phone. 

Innomar will also provide major updates at certain times by sending download links via 

e-mail to the users when available. 

When using the ISE software for the first time on a PC, the installation of the 

drivers for the USB hardware dongle is required in advance. 

It’s recommended to carry out processing on the local hard drive, since 

processing over the network tends to be slower. For better performance it is 

also recommended, not to start the software from a removable media. We 

recommend to use a SSD when processing large SES-2000 data files 

The ISE software will save some settings, program parameters and window 

positions in the MS Windows Registry after the first usage. The registry key 

used is called “Computer\HKEY_CURRENT_USER\Software\Innomar\ISE”. 
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USB Hardware Dongle 

The ISE software requires an USB hardware dongle, which is compatible with all USB 

interface standards. Plugging the dongle into a free USB socket will start the 

installation process automatically. MS Windows 10 provides the dongle driver 

automatically. For MS Windows 7 a dongle driver is provided by Innomar. The driver 

can be installed from the CD or USB pen drive manually. The driver is located in the 

directory called “Windows7_MatrixDongleDriver”. For USB dongles shipped 2015 or 

earlier a driver is provided as well. This driver might be used if the automatic 

installation under MS Windows 10 failed. The driver is located in the directory called 

“Windows10_MatrixDongleDriver_DonglesBefore2015”. 

Requirements for a personal computer 

A personal computer with Microsoft® Windows® operating system is required. The ISE 

software is compatible and tested with Windows 7®, Windows 8®/8.1® and Windows 

10®. As a minimum for a processing workstation we suggest a dual core processor with 

min. 2 GHz, at least 4 GB RAM and a standard hard drive. For processing larger data 

files, the working speed can be significantly increased by using more RAM, multi core 

processors and SSD drive. The screen resolution should have a minimum of 1024x768 

pixel. A free USB slot is necessary for the hardware dongle. A mouse or compatible 

control device is absolutely necessary to operate the software, particularly when 

picking reflectors or digitizing objects and features. In order to create print outs with the 

ISE software a Microsoft® Windows® compatible printer is needed. 

The recommended hardware for the processing workstation is: 

- Intel i5, i7 or i9 processor 

- 8 GB RAM or more 

- SSD drive for storing the data  

- a screen with Full HD resolution (1080p with 1920 x 1080 pixels) 

- when using the GIS Extension of the ISE software a second monitor is highly 

recommended in order to have one screen for the map display and the other 

screen for the display of the seismic sections 

- when using the GIS Extension of the ISE software with large background maps and 

numerous track lines a dedicated graphics adapter is highly recommended in order 

to improve the visualization performance 
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General Processing Preparation Steps 

ISE is a post processing software tool for the parametric sediment echo sounders SES-

2000. With ISE digitally stored data can be loaded. The visualization of the echo data 

can be adjusted by different processing algorithms and processing methods. 

Furthermore the data correction is possible for instance: tide and/or position.  

SES-2000 has the capability to store raw and demodulated data, which can be 

converted to SEG-Y, XTF and ASCII format for processing with third party software. 

The recorded data by the SESWIN software is available in two formats. SES format 

represents frequency envelope and RAW format represents full wave form data. The 

SES-2000 compact has the RAW format optional; the basic version stores only the 

frequency envelope. 

File Management 

It is highly recommended to create a structured database. Use one folder to keep the 

original data files and create a working folder within stored file are to be modified. That 

will prevent from any corruption of acquired information.  

Coordinate Transformation 

An important step for the preparation of the data is the transformation of the 

coordinates. This is always necessary if the output of the results should be in a 

coordinate system that was not set during recording. Apart from this, it is 

recommended to work in a metric coordinate system, as some of the tools are more 

comfortable to use. The transformation tool can be found under Tools → Coordinate 

Transformation. 

① Choose the directory with the data files. 

② Choose the file extension filter according to the data files. 

③ Select one or multiple files. 

Data Source and Destination 

④ Set the SIS-IDs according to the recorded Lat/Lon and the 
corresponding hemisphere.  

⑤ Set the SIS-IDs for as destination for the new coordinates. The 
content of these fields will be overwritten with the new coordinates. 
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⑥ Set the format of the Lat/Lon values according to the recorded Lat/Lon 
values.  

⑦ Set to projected conversion for coordinate transformation.  

⑧ Consider to set a prefix to generate new data files. Make sure the box 
is ticked and text prefix is given. 

Conversion Parameters 

⑨ Select the desired coordinate system from the list.  

⑩ When UTM projection is used, the UTM zone can be determined 
automatically. 

⑪ Start the coordinate transformation. 

Interpolation 

An interpolation of the coordinates is in general recommended. If the update rate of the 

positioning system is less than the ping rate of the SES-2000 system, an interpolation 

should be always done. For example GPS update rate 5 Hz and Ping rate 20 Hz: so 

only every 4th ping has a measured position. In such cases it is necessary to interpolate 

between true received positions so that every ping can have an individual coordinate 

position. The interpolation can be done in permanent or temporary manner. This 

interpolation is for metric coordinate systems such as UTM. 
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Permanent Interpolation 

This type of interpolation affects all the records representing the positions. These 

changes will be saved within the data file and are permanently.  

Start the ISE software and go to Tools → SIS Process of the menu to open the dialog 

which contains the interpolation functionality. More options given in this tab and other 

tabs will be explained in chapter How to use SIS Process Tools. 

① Choose the directory with the data files. 

② Choose the file extension filter according to the data files. 

③ Select one or multiple files. 

④ Consider to set a prefix to generate new data files. Make sure the box 
is ticked and text prefix is given. 

Interpolation Single SIS 

⑤ Set the SIS-IDs to be interpolated. This example has metric UTM 

coordinates on SIS field 7 and 8.  

⑥ Press the button Interpolate to execute the interpolation. 
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Temporary Interpolation 

It can be enabled via the loading dialog window during the file loading process, if the 

red highlighted tick box is checked. Be aware this interpolation won’t be saved into the 

file.  

Profile List (optional) 

In order not to lose the overview of larger processing sessions, it is advisable to create 

a log file. For this purpose the ISE offers a tool to extract header information of the data 

files to an ASCII file. 

Start the ISE software and go to Tools → Profile List to open the dialog which 

contains the functionality of  extraction of the header information.   
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① Choose the directory with the data files. 

② Choose the file extension filter according to the data files. 

③ Select one or multiple files. 

④ Enter an output file name with the extension. 

⑤ Tick the desired information (possible several in one time) 

⑥ To know the exported order tick the header check box. 

⑦ Start the log file generation. 

This information can be imported into third party software such as Excel® and can be 

rearranged for a better viewing. 

Loading Data 

The loading of Files 

For loading the data files with The Load Data Dialog it is highly recommended 

to use the GIS module which is described under How to work with the GIS 

module. Otherwise The Load Data Dialog can be opened as explained here. 
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Start the ISE software and either go to File → Load Echo Data of the menu or select 

the icon (when hovering above any icon the description is visible), with tag Load 

Echo Data, to open the Windows® file browsing dialog. Dependent on the selected file 

type The Load Data Dialog window will popup. 

There is a vast range of different survey types and depending on survey targets the 

appropriate setup of The Load Data Dialog is crucial to achieve desired results.  

The Loading of SES Files 

The following paragraph describes the needed steps to open a SES-2000 data file. 

The essential settings are highlighted with red boundaries. The optional settings are 

highlighted with yellow boundaries. A few settings cannot be changed without 

reloading the data file. All other settings on the load dialog can be changed in The 

Signal Processing Dialog which is reached in the menu Extra → Signal 

Processing.The explanation for the single components can be found at the section 

Load Dialog SES Data.  

① Select the desired Channel. HF (high frequency) in general gives 

better seafloor definition and is often used for the bathymetry. The LF

(low frequency) is penetrating the seabed and gives information about 

the strata. 

When during acquisition the multi frequency data were acquired then 

desired low frequency can be selected from the pull down menu 

Frequency. 

② Select the SIS-IDs which contain the position coordinates. Those 

position values are used for all export functions and cannot be 

changed during the processing. Further select a source for the 

heading data. 

The frequency channel and the SIS-IDs cannot be changed 

without reloading. 

③ Optional different accumulation methods can be applied to improve 

the signal to noise ratio. A more detailed description can be found 

under The Load Data Dialog → Accumulation. 

The track accumulation cannot be changed without reloading. 
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④ Optional different algorithms can be applied to visualize the data. 

Furthermore different filters and thresholds can be used to improve 

the signal to noise ratio. More information can be found under The 

Load Data Dialog → Signal Processing. 

⑤ Miscellaneous options such as tide correction or mirror data can be 

used for further adjustments. All options are described under The 

Load Data Dialog → Special.   

The Loading of RAW Files 

The following paragraph describes the needed steps to open a SES-2000 raw data 

file. The essential settings are highlighted with red boundaries. The optional settings 

are highlighted with yellow boundaries. A few settings cannot be changed without 

reloading the data file. All other settings on the load dialog can be changed in The 

Signal Processing Dialog which is available in the menu Extra → Signal 

Processing. The explanation for the single components can be found at the section 

Load Dialog RAW Data. 

① Select the desired Channel. HF (high frequency) in general gives 

better seafloor definition and is often used for the bathymetry. The LF

(low frequency) is penetrating the seabed and gives information about 

the strata.  

When during acquisition the multi frequency data were acquired then 

desired low frequency can be selected from the pull down menu 

Frequency. 
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② Select the SIS-IDs which contain the position coordinates. Those 

position values are used for all export functions and cannot be 

changed during the processing. Further select a source for the 

heading data. 

The frequency channel and the SIS-IDs cannot be changed 

without reloading. 

③ Optional different accumulation methods can be applied to improve 

the signal to noise ratio. A more detailed description can be found 

under The Load Data Dialog → Accumulation. 

The track accumulation cannot be changed without reloading. 

④ Optional different algorithms can be applied to visualize the data. 

Furthermore different filters and thresholds can be used to improve 

the signal to noise ratio. More information can be found under The 

Load Data Dialog → Signal Processing. In order to take advantage 

of the noise filers, the data have to be demodulated. If no Pre-Filters 

and no Demodulate modus have been set up, the full content of the 

raw data will be visualized (positive and negative phase). In 

combination with these settings the Red-White-Blue and Red-White-

Black palettes can be used. Consider also not to use the median filter.

⑤ Miscellaneous options such as tide correction or mirror data can be 

used for further adjustments. All options are described under The 

Load Data Dialog → Special.  Due to the high sample rate of the raw 

data in combination with a large range the vertical exaggeration can 

be very strong. To reduce the vertical exaggeration the sample rate 

can be decreased by a factor.  
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ISE User Interface 

The ISE Screen 

When double clicking on the ISE icon, the ISE main screen appears. The software is 

designed as a common Windows® MDI application. This means it is possible open and 

work with different data files at the same time in the same application space. The only 

limitation for opening files is the memory space. The ISE screen is divided into a main 

menu, the workspace, where all opened windows are arranged, a tool bar with some 

speed buttons, for instance access to functions, and a status bar at the bottom of the 

main window with some program information. Each opened data window has its own 

tool bar with some speed buttons and an info panel at the top and a status bar at the 

bottom. Additionally, some tool windows can be opened, which are free placeable on 

the screen. They give access to special functions or contain extra information about the 

data. An example is the zoom window, which allows zoom in a certain area around the 

cursor position.  

The ISE Tool Bars and Status Bars 

The main application window and every data window have their own tool bar. These 

groups of buttons provide quick access to commonly used commands. 

A quick hint will appear if hovering the mouse over one of the tool bar buttons. 

The main application window has a status bar with program information and every 

data window has a status bar with some information about the loaded file. A status 

panel below the tool bar of the data window shows some information about the data 

below the actual cursor position, e.g. the time. 
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The Main Tool Bar 

This tool bar on the upper side of the main application window contains some buttons 

for quick access to program functions, e.g. “open data file” and “save layer file”. The 

main tool bar includes the following buttons: 

Button Description 

Load Echo Data Opens an open dialog to select data files for loading 

into the ISE software. 

Open Layer File Opens an open dialog to select a layer file in order to 

load the saved layers into the active data window. 

Save Layer File Saves all digitized layer of the data window, in the 

previous loaded layer file. If no file was loaded, the 

standard Windows® save dialog is opened.  

Print Graphic Prints the echo plot of the active window. 

Write Water Depth to 

Active Data File

Overwrites the on-line calculated water depth or 

overwrites a SIS field with the calculated water depth 

from the active layer. 

Save manipulated SIS to 

SES-File

The icon becomes enabled after using the SIS 

manipulate function. It saves the changes to the SES 

file and updates the track within the GIS module.   

Show File Information Shows the parameters of the file in the active data 

window, e.g. recording time, frequency, amplifier 

setting etc. 

Select Color Palette Sets color palette for the actual data window. 

Signal Processing Selects and configures the digital signal processing 

for the echo sounder data in the active window. 

Tool Box Opens or closes the tool box window. 

Zoom Box Opens or closes the zoom window. 

Overview Box Opens or closes the overview window. 

GIS/Track Box Opens or closes either the GIS window or the track 

plot window depending on which version is installed. 

Target Picker Box Opens or closes the target picker window. 

Segment Box Opens or closes the segment box window. 
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The Data Window Tool Bar 

Every data window has its own tool bar. A combo box for the selection of the active 

layer is included in the tool bar. There are twenty layers per data for separate editing 

available. The data window tool bar includes the following buttons: 

Button Description 

Hide Layer Allows to show or to hide the active layer. The layer 

data themselves won’t be modified. 

Pen Color Opens the standard Windows® color dialog and allows 

selecting the pen color for the active layer. 

Pen Width and Mode Selects the pen width for the active layer in the range 

between 1 and 5 pixels. Additionally it is possible to 

select between freehand and line mode. 

Capture Mode Starts and stops the capture mode. During the 

capture mode the program tries to calculate 

automatically the layer position under the cursor or in 

a special mode for a bigger range starting from the 

cursor position. 

Text Block Inserts a text block into the actual data window. 

Undo Segment Removes the last edited segment from the active 

layer. 

Delete Layer Deletes the whole active layer. 

Copy Layer Copies the layer contents into the ISE clipboard. 

Paste Layer Copies the ISE clipboard contents into the active 

layer. 

Merge Layer Merges the ISE clipboard contents into the actual 

layer. 

Undo Layer Undoes the last change in actual layer. with the ISE 

layer undo buffer contents 

Mirror Layer Performs a mirror function to the whole layer data. 

Scale Layer Scales the layer data in the horizontal direction. 

Add Offset Adds an offset to the active layer in the vertical 

direction. 

Smooth Layer Smooth the active layer. 

Remove Peaks Tries to remove peaks from the active layer. 

Remove Overlaps within Rebuilds a layer and deletes all overlapping parts. It’s 
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Layer also a tool to remove peaks when editing layers. 

Manipulate SIS Fields Interpolates or deletes selected SIS fields within a 

particular area. 

Mark Block Marks a block of the data for separate processing or 

exporting parts of the data. 

Unmark Block Resets a previously marked block. 

The Main Status Bar 

The Main Status Bar shows the available system memory. It is divided into free 

physical memory and free virtual memory which is the amount of free hard disk space 

available as system memory. The whole free memory can be used by the application 

for loading data files and processing tasks. The more free physical memory is 

available, the faster the computer system can handle the data and the faster the 

program can run. 

The Data Window Status Bar 

The Data Window Status Bar shows some information about the file, loaded into the 

data window. There are shown some information’s of the survey such as the name of 

the ship, the name of the travel, the name of the area, the profile number, the speed 

of sound and some applied processing settings. 

The Data Window Status Panel 

The Data Window Status Panel is located below the Data Window Tool Bar. It 

shows different values depending on the actual cursor position. While moving the 

mouse cursor over the echo plot these values will be updated instantly. On the panel 

there are shown the X position from the SIS data, the Y position from the SIS data, 

the Z value in the echo plot, the date and time, the total height of the echo plot, the 

ping number, the actual amplitude, the mean amplitude around the cursor position 

and the online calculated ping rate as well as the actually achieved ping rate within 

the brackets. 

If in the environment option the display of all SIS strings is enabled, the status panel 

has two lines. The second line shows the contents of all eight SIS strings. 

If the loaded data file is a Side Scan file then the projected coordinates are also 

shown with the offset from the track (heading data in one SIS field or from a motion 

sensor required) 

The Ping Information Panel 

The ping information panel can be found on the left hand side of the main ISE screen. 

The panel provides two tabs. The first tab called Signal, shows the signal strength for 

the entire trace at the cursor position based on the chosen signal processing 

algorithm. The tab Ping Information gives some more information e.g. motion sensor 
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values, amplification values or the calculated foot print size at the current cursor 

position. 

The ISE Menus with corresponding Dialogs 

On top of the ISE window the main menu can be found. The most functions of the 

program can be accessed from here. Some of the menu commands are accessible 

with a Hot Key, which is shown in the menu string. 

Menu commands are disabled if they are not accessible for certain reasons. 

File Menu 

The File Menu allows selecting files to open, save layer files, save pictures, export 

data files and print data files. The last four opened files are held within the File Menu

for quick access. The following menu commands are accessible: 

Command Description 

Load Echo Data Opens an open dialog to select data files for loading 

into the ISE software.

Open Layer File Opens an open dialog to select a layer file in order to 

load the saved layers into the active data window. 

Close File Closes the active window. 

Open Layer Definition Opens a definition file for the layers which are 

attached to the active data window. 

Save Layer File Saves all digitized layer of the data window, in the 

previous loaded layer file. If no file was loaded, the 

standard Windows® save dialog is opened. 
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Save Layer File As Opens a standard Windows® save dialog in order to 

save all digitized layer of the data window into a 

selectable file.  

Save Layer Definition Saves the definition of the layers of the active data 

window into a file. 

Export Fledermaus 

Curtain

Exports the active data window into a QPS 

Fledermaus sd file. 

Export Marked Section as 

SES File

Saves the marked section as individual SES or RAW 

file depending on the original data format. 

Export Processed 

SES/RAW-File

Exports the active data window with all applied 

settings into a SES/RAW file depending on the 

original data format. 

Export Graphic Exports the actual window contents (annotated echo 

plot) into a graphic file. 

Export Layer Data Exports the layer information of the active window into 

ASCII files for an easy import into other software 

packages, e.g. GIS or volume calculation tools. 

Export Layer as CODA-

File

Exports the layer information of the active window into 

ASCII files in CODA format based on layer segments. 

Export Layer as PIPE-File Exports the layer information of the active window into 

ASCII files in PIPE format based on layer segments. 

Export Layer as SVG-File Exports the layer information of the active window into 

SVG files (Scalable Vector Graphics) based on layer 

segments. 

Export Layer as DXF-File Exports the digitized layer into an AutoCAD *.dxf file. 

Export Signal Traces Exports the data from signal traces within a marked 

block into ASCII files. 

Export Window Captures the application window into a graphic file. 

Print Prints the data of the active window. 

Recent File List Lists the last 4 opened data files.  

Exit Closes all open data files and exits from the 

application. 

The ISE File Dialogs  

This section deals with the dialogs to set or to modify parameter for selected function 

or to choose between alternative options. Some of the dialogs are self-explanatory, 

e.g. the color palette dialog or the pen dialog, however others require some 

descriptions. The dialogs have to be closed, before the user has access to the open 

data windows again. 
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The Load Data Dialog 

The Load Data dialog summarizes all needed settings to load SES-2000 data files. 

Some of those settings can be changed after loading the file and some not.  

The ISE post processing software supports both Innomar’s SES data format and 

Innomar’s RAW data format. The *.ses data are already filtered and demodulated 

whereas *.raw are unfiltered and unmodulated. Therefore the load data dialog for 

*.ses data differs a little in choices of signal processing algorithms and functions 

compared to the load data dialog for *.raw data.  

Load Dialog SES Data 

• Channel 

The SES data format is able to store multiple channels e.g. low and high frequency 

as well as data which were acquired by different transmit modes e.g. multi 

frequency mode or beam steering mode. 

Channel Channels to load can be selected from the drop down 

list  

LF – low frequency 

HF – high frequency 

LF/HF both channels will be loaded into the program 

(that function is not supported by the Process Script

tool) 

Angle in ° SES-2000 systems with beam steering capability are 

able to transmit the soundwave in different angles if 

the beam steering mode is enabled. These angles can 

be selected from the drop down list to load into the 

software. 

Frequency [kHz] SES-2000 systems with enabled multi frequency 

mode have the capability to transmit alternating up to 

three different low frequencies. These frequencies can 

be selected from the drop down list to load into the 

software.  

• Accumulation 

Accumulation is a signal processing function to reduce the noise level in order to 

improve the signal-to-noise ratio of the echo data.  

Stacking There are n consecutive echo signals added up to 

calculate one new echo with enhanced SNR to be 

displayed. Then the original signals will be discarded 

and the next n received echo signals are used to 

calculate a second echo to be displayed. Thus not 

only the SNR is enhanced, there is also a data 

reduction (compression) of the resulting echo print. 
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The reduced amount of data is useful if the ping rate is 

very high and the survey is not aimed to find very 

small features in the sub-seafloor. If the main task is 

searching small objects like pipes, stacking should be 

set to a very low value (1 or 2). 

Smoothing There are n consecutive echo signals added up to 

calculate one new echo with enhanced SNR to be 

displayed. Then the oldest original signal will be 

discarded and the next received echo signal is used 

with the remaining previously received signals to 

calculate a second echo to be displayed. Thus the 

SNR is enhanced without data reduction. 

Track This is in fact the "stacking" algorithm with variable 

width n. In this case n is chosen automatically to have 

a constant number of traces per distance unit in the 

echo print. Thus one gets a track-made-good 

corrected echo print. 

• Palette 

Palette Selection of different color tables to visualize the echo 

data 

• Signal Processing 

The signal processing is used to visualize the echo data. With help of the different 

parameters the signal-to-noise-ratio can be improved for a better interpretation and 

presentation of the echo data. 

Algorithm Sets the display mode of the echo data 

Algo 1P: displays the gradient of the echo amplitude 

for a better visualization of amplitude changes 

Algo AMP: displays the amplitude of the echo 

envelope

Threshold Table Sets the parameter for the threshold table either to 

linear or logarithmic distribution. 

Threshold Table Minimum: Defines the lowest 

threshold level.  

Threshold Table Maximum: Defines the highest 

threshold level 

The threshold table is used to map the signal 

amplitudes to a selected color palette. By controlling 

the Min/Max values the noise level (min value) and 

the contrast (max value) can be changed. 
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Normalize Amplitudes Sets an equal gain for the amplitudes to compensate 

various gain settings during the data acquisition.  

Soft TVG [db/m] Enhances the gain with increasing time (distance) 

beginning from the seabed in order to compensate 

attenuation by absorption and spreading.  

Reduce Noise Enables or disables a noise reduction algorithm.  

Decrease Sample Rate 

with Factor Two 

Enables or disables reducing of sample rate by factor 

2 in vertical direction. This can be useful for data files 

with large ranges. 

• NAV Data 

The SES data format provides 8 SIS fields to record the navigation information 

together with acoustic data. Depending on the field operator decision the 

coordinates can be found on different SIS-IDs. In this area of the load dialog all 

relevant navigation information can be set. It is possible to work either with Lat/Lon 

or metric coordinates. The coordinates selected here are used for all export 

functions as output coordinates. It is recommended to use a metric coordinate 

system because many functions are more comfortable to use with metric units. If it 

is needed to convert Lat/Lon to a metric system the ISE software provides a 

converter tool under the Tools menu so called Coordinate Transformation. 

Displays the current assignment of the SIS-ID fields.  

SIS-ID for X-Position Select the SIS-ID from the drop down list with the 

desired X position. 

SIS-ID for Y-Position Select the SIS-ID from the drop down list with the 

desired Y position. 

Heading Data Source Select the source for the heading information from the 

drop down list. The true heading information is 

important if Side Scan data will be loaded. It is 

needed in combination with digitized seabed after 

spikes removing to calculate instantly positions of 

spotted objects.  

Use Clipping Rectangle Defines a rectangle from lower left and upper right 

corner to exclude positions during loading data.  
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• Extend Range 

Enable compensation of different data ranges to maintain a constant vertical scale. 

Top [m] Adds the selected number of meter to the top of the 

echo print. 

Bottom [m] Adds the selected number of meter to the bottom of 

the echo print. 

• Special 

Mirror Data Flips (mirrors) start and end of the echo print. This 

function is applicable to one and to several lines. 

When the automatism is being selected the system 

will recognize itself which lines shall be mirrored, 

according to chosen mirror direction – N,E,S,W.  

Median Filter Enables or disables a digital filter to remove noise 

peaks from the echo data e.g. stripes from other echo 

sounder or regular patterns from electrical noises.  

Interpolating metric 

coordinates and PC – 

Time  

Enables or disables interpolation of the coordinates in 

the active window. This is a temporary procedure. The 

data file itself will not be modified. 

Heave Correction Enables or disables the heave correction for the echo 

data. It’s only functional if motion sensor data were 

acquired during survey.  

Tide Correction Applies a tide gauge to the echo data. 

Zero Level [m] Enables or disables definition of a new Zero-Level 

which allows putting a constant offset on the echo 

plot. 

Z – Correction [SIS] Enables or disables the usage of the maximum value 

of the Z component found in selected SIS-ID as Zero 

Level shift. 

Sediment Velocity 

Correction [m/s]  

Sets a different sound velocity for the sub bottom. 

That function needs a corrected and clean online 

water depth.  
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Load Dialog RAW Data 

As mentioned before, the loading dialogs differ slightly. Therefore, the following 

section deals only with the differences.  

• Signal Processing 

The signal processing is used to visualize the echo data. With help of the different 

parameters the signal-to-noise-ratio can be improved for a better interpretation and 

presentation of the echo data. 

Palette Selection of different color tables to visualize the echo 

data. For RAW data two more color tables are 

available. The additional color palettes working for 

unmodulated bipolar data only. 

Pre-Filter This is an adjustable band pass filter. The option 

“optimized” will automatically choose the bandwidth 

related to signal frequency and pulse length used 

during acquisition. The option “light” will result in a 

slightly wider filter band width and the option “strong” 

will narrow the band width for an increased noise 

reduction.
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Demodulate This feature will apply an envelope function to the full 

wave form signals of the RAW files. As a result the 

data become unipolar and in most cases the 

interpretation and digitization of reflectors is improved. 

However, the phase information is not retained within 

the envelope data. There is an option to apply a low 

pass post filter after the envelope function for an 

increased noise reduction. 

Reduce Noise Data with an envelope function applied may be 

processed with additional noise filters. The WD based 

algorithm will determine the noise content within the 

water column, based on the digitized water depth 

within the data file and subsequently subtract it from 

the signal. The Small Range and Big Range 

algorithms are useful if noise is not uniformly 

distributed over a series of traces and will estimate 

and reduce the noise with the method of 

normalization. 
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The Open Layer Dialog 

That dialog is a simple file selector which lists all *.sch files within the selected folder. 

Directory Browser Selects single layer files (*.sch) to reimport onto the 

current echo data 

The Open Layer Definition Dialog 

The Open Layer Definition dialog is a standard Windows® open dialog and allows to 

browse through the windows folder directory and to choose a single *.sdd file. This file 

contains the properties of each layer. Those properties e.g. layer name, pen color or 

pen size can be set and saved within the Environment settings. 

The Save Layer File Dialog 

There is actually no dialog under this menu. It is an option to save. A dialog appears 

only if the layer within the current data window was not saved yet. In that case the 

Save Layer File As dialog will be opened otherwise the loaded layer file will be 

overwritten. 

The Save Layer File As Dialog 

The Save Layer File As dialog is a standard Windows® save dialog and allows to 

navigate thru the windows folder directory and to choose a location for saving the 

layer files. (*.sch)  

The Save Layer File Definition Dialog 

The Save Layer File Definition is a standard Windows® save dialog and allows to 

navigate thru the windows folder directory and to choose a location for saving the 

local modified layer properties to a *.sdd file. 
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The Export Fledermaus Curtain Dialog 

Fledermaus is an interactive 4D geo-spatial processing and analysis tool. This export 

dialog allows to visualize either *.ses or *.raw data files as SBP curtains or fence 

diagrams in the Fledermaus software or the free available iView4D tool.  

• File Options 

Create a New 

Fledermaus SD File 

Exports the SBP data into a new SD file 

Add Data to Existing 

Fledermaus SD File 

Exports the SBP data into an existing SD file thereby 

the data will be added 

Input File Name When ‘Add Data…‘ option is used the existing SD file 

can be selected 

Output File Name When ‘Create New…’ option is used file location and 

filename can be selected 

• Options 

Transparency Selectable background options: 

No Transparency the file will be exported as shown 

in the ISE  

Transparency Background Color 

Transparency Water Column 

Transparency Water Column + Transparency 

Background 

The Export Marked Section As SES/RAW-File Dialog 

This function is only enabled when a section within the current data file is marked by 

the mark block button. It opens a standard Windows® save dialog and the marked 

section will be exported into a new data file. This tool can be used to create small data 

snippets in order to send them for instance as e-mail or to remove parts of the echo 

data and replaces The Cut Data Files Tool. 
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The Export Processed SES/RAW-File Dialog 

By exporting a processed data file a new ses/raw file depending on the loaded format 

will be. Only the data of the current channel will be saved with all settings applied, 

such as digital filters or stacking/smoothing. The data should be saved in Algo Amp

display. If saved in Algo 1P mode the real amplitude values are lost and cannot be 

recovered from Algo 1P data file anymore.  

If the processed file is to be loaded back into the ISE software, the settings of 

the previously generated file, need to be switched off, otherwise they will be 

applied twice.  

The Export Graphic Dialog 

For data presentation the echo data can be exported into various raster graphics e.g. 

formats such as gif, tiff or jpeg format. The term coordinate, is related to the selected 

SIS-ID’s which were chosen for the X/Y position during loading the file. This function 

works also with the Scrip Tool.  

Opens the standard Windows® save dialog to select 

the name and folder for saving the graphic. The file 

selector allows switching between various file formats.

• Picture Rules  

Mark Block only The function requires a marked section to be enabled 

(Mark Block) and creates a picture of the marked 

section only. 

Sections[+/- pings] Adds the given number of pings around the chosen 

kind of marker and creates a raster graphic of that 

area only.  

• Around marked Targets 

• Around manual Marker 

Marked Targets can be imported under Probes 

Overlay Target Position. Manual Markers were set 

during the data acquisition within the SESWin 

software.  

• Special Options 

Additional Pictures from 

Layer Target Position 

Exports pictures with a selectable size around a target 

position. This function requires loading a layer with 

saved target positions.  

Write Graphic File with 

header and annotation 

Adds data specific information and coordinates to the 

raster graphic.  

Write ASCII File Writes an additional ASCII file with: 
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• All coordinates  

• First and the last coordinate only  

The Export Layer Data Dialog 

This dialog allows setting the parameters for exporting the edited layers into 

compatible ASCII files. If no options are chosen the output file consists of x, y 

(depending on what was selected for X/Y during file loading) and a z value. Those 

ASCII files can be imported for further processing or presenting into several third party 

software packages such as Surfer or other mapping software. The function is 

accessible also by the key combination [Ctrl]+[E]. It also works together with the script 

tool.  

• Output 

File Name Sets the filename and location for the output file. 

File Options Provides several option for writing the data: 

• All to One File: Writes the content of Layer1 

to Layer20 into a single file. 

The Layer Selection must be set to All 

Layers.

• All to One File and Attach to Existing File: 

Appends the content, depending on the Layer 

Selection to a single file.

• Separate Files for Layer Selection exports 

the content of the layer in separated files, 

when chosen All Layers at Layer Selection. 

Each file gets the layer name as prefix. 
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Layer Selection Sets the layers to be exported. 

• Active Layer exports the selected layer within 

the data window only

• All Layers exports all layer from Layer1 to 

Layer20 

• All visible Layer exports all not hidden layers. 

Delimiter Sets a desired delimiter to separate the columns such 

as Space, Comma, Semicolon or Tabulator

Header Adds the column description on top of each column. 

• Additional Columns 

String SIS-ID1-8 Adds additional columns to the output file with the 

content of SIS-ID1 to SIS-ID8 

Append Layer Name Adds an additional column to the output file with the 

layer label.  

Append PC Date and 

Time 

Adds an additional column to the output file with PC 

date and time 

Append Profile Number • First row: Adds an additional column to the output 

file with the profile number to the first row only.

• All rows: Adds an additional column to the output 

file with the profile number to all rows. 

Z-Value relating to 

window start after SIS-

Strings 

Adds an additional column to the output file with Z-

values related to start of the data window, 

independent of the absolute Z-values. 

Gain and maximum 

amplitude around layer 

Adds additional columns to the output file with the 

gain and the maximum amplitude around the layer. 

This function is enabled in Algo Amp display mode 

only. The search bandwidth for the maximum 

amplitude can be modified. 

Add projected 

coordinates for Side 

Scan data 

Adds additional column to the output file with 

projected coordinates. This function is only working 

with Side Scan data. It also requests a clean seabed 

digitization and true heading values.  
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• Special 

Z-Multiplier Applies a multiplier to the Z-values. (unit conversion)  

Z-Offset Constant Adds a constant offset to the Z-values (transducer 

draft or any fixed vertical offsets) 

Z-Offset from SIS-ID Adds SIS-values from the chosen SIS-ID to the output 

values. 

This function is useful when RTK GPS heights 

in combination with the constant Z-Offset are 

used to reduce depths to a height datum.  

• Negate Z-Values: SIS-ID values can be 

negated. 

The Export Layer as CODA File Dialog 

The Coda file is a user specific ASCII file format following the scheme of the CODA 

processing suite. The CODA file export works similar to the Layer Export. The function 

is accessible also by the key combination [Ctrl]+[E]. It also works together with the 

script tool.  

• Output 

File Name Sets the filename and location for the output file. 

Output Data Selects the kind of Z-values to be exported into the 

CODA file: 

• Absolute Z-values

• Difference (depth) relative to seabed layer
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Layer Selection Sets the layers to be exported. 

• Active Layer exports the selected layer within 

the data window only

• All Layers exports all layer from Layer1 to 

Layer20 

• All visible Layer exports all not hidden layers. 

All to One File Exports all layer into one single file. 

Delimiter Sets a desired delimiter to separate the columns such 

as Tabulator, Space or Comma. Tabulator is 

defined by default at the format description. 

Output Format Sets the desired output format. Gives control of the 

content of the Coda file.  

Write header 

information to exported 

file 

Adds the column description on top of each column. 

• Options 

Depending on the chosen output format some options become enabled or 

disabled.  

Time Source Sets the SIS-ID as time source. All SIS-IDs (GPS 

time) or PC time are available.  

SIS-ID KP Sets the SIS-ID as source for the KP values. KP’s are 

the kilometer of pipeline or generally the kilometer of 

survey line and gives the distance along the line from 

the start.  

Layer with Seabed Sets the layer as source for the seabed information.  

When Output Data – Difference....is 

selected, here selected layer is treated as 

base. All differences will be calculated in 

reference to this layer. 

Remove Z-Values Sets a filter to remove Z-values outside the given 

range 

Z-Multiplier Applies a multiplier to the Z-values. (unit conversion)  
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Z-Offset Adds a constant offset to the Z-values (transducer 

draft or any vertical offsets) 

Add SIS-Value to 

Z-Value 

Adds SIS-values from the chosen SIS-ID to the output 

values. 

This can be useful if an external depth (multi-

beam depth) is available in order to get the 

absolute depth of a layer according to the 

external depth. 

The Export Layer as PIPE-File Dialog 

This dialog is to export layer data as PIPE files, an ASCII based format, based on the 

CODA format, but custom made for pipeline surveys. 

• Output 

Attach to Existing File Appends the data to the selected output file. 

File Name Sets the filename and location for the output file. 

• Layer/Delimiter 

Layer Sets the layers to be exported. 

• Export Active Layer (Pipeline) and Seabed

exports the selected layer for the seabed and 

the active layer as pipeline. 

• Export Active Layer (Pipeline) exports the 

active layer only. 

• Export Seabed only exports the seabed layer 

only. 

Delimiter Sets a desired delimiter to separate the columns such 

as Tabulator, Space or Comma. Tabulator is 

defined by default at the format description. 
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• Additional Columns 

SIS ID Time Sets the SIS-ID as time source. All SIS-IDs (GPS 

time) or PC time are available. 

SIS ID KP Same as described under The Export Layer as 

CODA File Dialog → Options

Layer with Seabed Sets the layer as source for the seabed information.  

Z-Multiplier Applies a multiplier to the Z-values. (unit conversion) 

Z-Constant Adds a constant offset to the Z-values (transducer 

draft or any vertical offsets) 

Positive Z-Values Writes positive Z values into the file. 

Remove Z-Values Sets a filter to remove Z-values outside the given 

range 
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The Export Layer as SVG File Dialog 

This tool allows exporting layer into a SVG file. The file structure is based on XML 

specification and stands for ‘Scalable Vector Graphics’. SVG files can be imported by 

several graphic programs and may be used for presentation purposes of interpreted 

results. 

• Output 

File Name Sets the filename and location for the output file. 

• Layer 

Layer Sets the layers to be exported. 

• Active Layer exports the selected layer within 

the data window only

• All Layers exports all layer from Layer1 to 

Layer20 

• All visible Layer exports all not hidden layers. 

• Options 

Z-Multiplier Applies a multiplier to the Z-values. (unit conversion)  

Scale to View Adjusts the image size to the template (page size) in 

the graphic software. 

Bounding Box Makes the borders visible by a bounding box. 

Echo plot as Bitmap Adds the echo data as bitmap file. This results in two 

output files.  

The Export Layer as DXF-File Dialog 

This dialog helps to export layer to make them available in AutoCAD. AutoCAD is a 

well-known construction software package which is also used to generate maps. For a 

comfortable import of layer the export tool will generate a dxf file. 
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• Output 

File Name Sets the filename and location for the output file. 

File Options Provides several option for writing the data: 

• All to One File: Writes the content of Layer1 

to Layer20 into a single file. 

The Layer Selection must be set to All 

Layers.

• All to One File and Attach to Existing File: 

Appends the content, depending on the Layer 

Selection to a single file.

Separate Files for Layer Selection exports the 

content of the layer in combination with Layer 

Selection All Layers in separated files. Each file gets 

the layer name as prefix 

Layer Selection Sets the layers to be exported. 

• Active Layer exports the selected layer within 

the data window only.

• All Layers exports all layer from Layer1 to 

Layer20. 

• All visible Layer exports all not hidden layers. 

• Options 

An additional layer will be created within AutoCAD, which provides the following 

profile information. The layer is named ‘Profile Information”. 

Profile Number Adds the profile number to the information layer. 

Area Name Adds the area name to the information layer. 

File Name Adds the filename to the information layer. 

Use projected 

coordinates for Side 

Scan data 

Adds projected coordinates to the AutoCAD layer. 

This function is only working with Side Scan data. It 

also requests a clean seabed digitization and true 

heading values. 

• Special 

Z-Multiplier Applies a multiplier to the Z-values (unit conversion). 

Z-Offset Constant Adds a constant offset to the Z-values (transducer 

draft or any fixed vertical offsets). 
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Z-Offset from SIS-ID Adds SIS-values from the chosen SIS-ID to the output 

values. 

This function is useful when RTK GPS heights 

in combination with the constant Z-Offset are 

used to reduce depths to a height datum.  

• Negate Z-Values: SIS-ID values can be 

negated. 

The Export Signal Traces Dialog 

For advanced signal analysis with external software packages this dialog allows to 

export single signal trace or groups of signal traces into ASCII files. To enable this 

function an area of the current data window needs to be marked. The file format can 

be seen under The ASCII Convert & Export File Format.

• Output 

File Name Sets the filename and location for the output file. 

• Export Rules 

Export an average of all 

marked traces 

Writes the average of all marked traces into a file. 

Export center trace of 

marked area only 

Writes the data from the trace in the middle of marked 

area. 

Export all marked 

traces to separate files 

Writes each trace within the marked area to a 

separate file. 

• Export Options 

Write sampled 

amplitude values 

Writes the sampled amplitudes as shown in the data 

window. 

Write normalized 

amplitude values 

The normalization will take into account the amplifier 

setting and the water depth. As a result the exported 

amplitude values are comparable for files or areas 

where different amplifier settings were used or the 

water depth has changed. 
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The Export Window Dialog 

The Export Window function creates a screen dump of the entire ISE screen. It 

opens a standard Windows® save dialog to set the location, filename and file format. 

The function is accessible also by the key combination [Ctrl]+[W]. 

The Print Dialog 

The dialog helps to prepare printing of echo plots. Every printer which is installed 

under the Windows® environment can be selected. The function is accessible also by 

the key combination [Ctrl]+[P]. 

• Printer 

Name Shows the selected printer name 

Opens the standard Windows® dialog for selecting 

and setting properties for printers installed under 

Windows®. 

• Print Range 

All Prints all pages. 

Page from Prints the selected pages only. 

The selected start and end page will be 

changed if the scale settings will be adjusted! 

• Preview 

Preview Displays a preview of the echo plot to be printed 

depending on the selected scale. Under the preview 

the number of pages to print is displayed. 

• Page Handling 

Print Page Header Adds data specific information to the print out.  

Print Annotation Adds coordinates to the print out. Coordinates are 

related to the selected SIS-ID’s which were chosen for 

the X/Y position during loading the file. 
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Fit to Page Sets a scale factor automatically to fit the echo plot to 

a single page.  

Fit to Page Height Sets a vertical scale factor automatically to fill out the 

vertical range of the page. 

Scale Echo Plot Height 

[mm per 1m Range] 

Sets a vertical scale factor. 

Scale Echo Plot Width  

[Pings per mm] 

Sets a horizontal scale factor. 

Edit Menu 

The Edit Menu allows setting up and selecting tools for the layer digitization. Among 

other things, there is an Undo function as well as a copy the actual picture to the 

clipboard function. The Edit Menu contains the following commands: 

Command Description 

Undo Last Segment Removes the last edited segment from the active 

layer. 

Delete Layer Deletes the whole active layer. 

Copy Layer Copies the layer contents to the ISE clipboard. 

Paste Layer Pastes the ISE clipboard contents into the actual 

layer. 

Merge Layer Merges the ISE clipboard contents into the actual 

layer. 

Undo Layer Replaces the actual layer contents with the ISE layer 

undo buffer contents 

Pen Gives access to the configuration of the layer editing 

pen, like the color, the pen width and the pen mode. 

Capture Mode Starts the capture mode for the layer editing. 

Text Block Inserts a text block into the actual data window. 

Mirror Layer Performs a mirror function to the whole layer data. 

Scale Layer Scales the layer in the horizontal direction. 

Add Offset Adds an offset to the active layer in the vertical 

direction. 

Smooth Layer Smooths the active layer. 

Remove Peaks Tries to remove peaks from the active layer. 
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Remove Overlaps within 

Layer 

Rebuilds a layer and deletes all overlapping parts. It’s 

also a tool to remove peaks when editing layers. 

Copy Graphic Copies the actual data window as a bitmap graphic 

into the Windows® Clipboard. 

Mark Block Marks a block of the data for separate processing of 

parts of the data. 

Unmark Block Resets a previously marked block. 

The ISE Edit Dialogs 

The Pen Dialogs 

There are actually two forms for setting the pen properties for the current data file. 

Color 

The dialog provides several colors for the active layer to be selected. Custom colors 

are not supported and are therefore disabled. 

Pen Width + Mode 

Pen Width Sets the pen width for the current layer 

Drawing Mode Sets the drawing mode to: 

• Freehand draws the layer by pressed left 

mouse button following the mouse pointer. 

• Lines draws straight lines as long the left 

mouse button is pressed. 

• Polygons draws straight chained lines by 

pressing the left mouse button. The polygon 

will be completed by double click on left 

mouse button. 

The Capture Mode Dialog 

The capture tool is used to digitize layer semi automatically. While the mouse pointer 

with pressed left mouse button is moved over the layer, it digitizes the layer 

depending on the defined settings. It can also be used in combination with the 
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Remove Overlaps within Layer tool to remove spikes, outliers or to redraw parts of a 

layer. The Capture Mode button in the tool bar is always pressed when the capture 

mode is active. To disable the capture mode press the Capture Mode button again. 

Mode In order to minimize fluctuations during digitization, 

there are three modes available. The first one is the 

default. 

• Maximum of Band the layer is determined at 

the maximum amplitude value within the 

search band. 

• 1st Maximum from Top the layer is 

determined at the first maximum amplitude 

value beginning from the top of the search 

band. 

• 1st Maximum from Bottom the layer is 

determined at the first maximum amplitude 

value beginning from the bottom of the search 

band. 

Search Band Width Sets a search band around the mouse pointer. The 

bandwidth can be selected in pixel, centimeter and 

meters.  

Amplitude Level [%] Sets the amplitude level as a threshold for the layer 

detection. It is enabled in combination with Maximum 

of Band mode only. The layer position is set at 

selected threshold of the maximum amplitude value 

beginning from the top of search band. 

Automatic Mode Enabled Enables the automatic search mode. The determined 

layer always appears automatically during the edit 

process. By hitting the left mouse button the layer will 

be acknowledged.  

Search length [Pixel] Sets the length in pixel for the pre-calculation area.   



52     ISE 2.9 User’s Guide 

Innomar Technologie GmbH, October 2017 

The Text Block Dialog 

For presentation purposes and for commenting echo plots it is possible to overlay text 

and symbols onto the echo plots. A list of up to 50 individual lines can be edited and 

placed on the echo plot at any position.  

All text entries can be saved within layer files. The text font will not be saved. 

The text is visible on printed echo plots and on exported graphics too.  

Text List Lists all text entries placed within the current data 

window. The text editor for entering the text can be 

found below the text list. For each text a pre-defined 

symbol can be selected from the drop down menu left 

of the text editor. All text entries can be modified in 

content, position or symbol, when the concerning 

entry is highlighted in the text list. There is also a 

function to delete the entire list.  

Text Properties Sets the general text properties. These settings are 

valid for all text entries within the current data window. 

• Select Font allows selecting any Windows®

font or color for the overlaid text. 

• Transparent Drawing sets a transparent 

background to the text. 

• Text Invisible allows hiding all text entries. 

• Double sized symbols scale the symbols by 

factor two. 

The overlaid text can be exported into a ASCII text 

file. The text will be saved together with the content of 

SIS-IDs at the text position. 
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The Scale Layer Dialog 

Due to different accumulation rates (Stacking factors) during the file load, it might be 

that the saved layer does not fit to the echo data anymore. To correct this, layers can 

be adjusted by applying a scale factor. 

Scale Calculates a scale factor by entering the stacking 

factor of the current data window in the first box and 

the stacking factor of the data file where the layer was 

drawn in the second box. 

Scale all layer Optional applies the scale factor to all layers. 

The Add Offset Dialog 

This function allows shift the layer in vertical and horizontal position. This can be 

useful when a high amplitude level was used during the layer digitization to avoid 

spikes. Then the layer position appears deeper than it should be. This can be 

corrected by moving up the layer by 1 or 2 pixels. Negative values are accepted to 

move a layer down.  

Offset The offset can be given in pixel, cm and meter. 

Vertical sets the vertical offset for the active layer in 

selected unit. 

Horizontal sets the horizontal offset for the active 

layer in selected unit. 
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Marked Block Only Applies the selected offset to the layer for the marked 

area only.  

The Smooth Layer Dialog 

The active layer can be smoothed to get a more continuously line and to remove small 

peaks in the layer line.  

Values Sets the number of values for the calculation. Higher 

values result in a more smoothing effect.  

The smoothing operation with even values will 

produce a small horizontal shift of the 

recalculated layer therefore odd values are 

selectable only. 

Marked Block Only Applies the smoothing to the layer for the marked 

area only.  

The Remove Peaks Dialog 

The Remove Peaks function can be used to remove peaks in the active line of the 

active layer, which sometimes appears in automatically calculated layers.  

Peak Height Sets the peak height to be removed in the selected 

unit. The peak height can be defined in pixel, cm or 

meter.  

Marked Block Only Applies Remove Peaks only for the selected area.  
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The Remove Overlaps within Layer Dialog 

During the digitalization with the “Capture Tool” it might be that two segments are 

overlapped. This means that one position can have two different z values. That could 

result in unexpected behavior during export the data. This function will prevent from 

such behavior by removing all overlapping layer parts. This function is also a very 

useful to remove spikes within a layer. Spikes can be removed by redrawing the 

particular place by using the “Capture Tool” or even free hand. The “Remove 

Overlaps within Layer” tool rebuilds the layer and merges all drawn layer parts 

together. 

Rebuild layer and merge 

overlapping segments 

Rebuilds the layer and merges all overlapping parts 

into a new layer composed of one segment 

Rebuild layer and split into 

new segments 

Rebuilds the layer and merges all overlapping parts 

into a new layer and split the layer into segments with 

selected length. 

Pixel/Segment Sets the segment length.  

Rebuild ALL layers (NO 

Undo available) 

Executes the function for all layers. This cannot be 

undone. 
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Extra Menu 

This menu contains commands for special tasks, like the configuration of the signal 

processing, the water depth calculation and some user adjustable functions such as 

the color palette or the ruler definition. The Extra Menu contains the following 

commands: 

Command Description 

File Information Shows the parameters of the file in the active data 

window, e.g. recording time, frequency, amplifier 

setting etc. 

Palette Sets color palette of the actual data window. 

Signal Processing Selects and configures the digital signal processing for 

the echo sounder data in the active window. 

Ruler Lines Changes the number of ruler lines which can be seen 

on the echo plot. The start value and the distance 

between two lines are configurable. 

Motion Sensor Lines Inserts curves of the values from a motion sensor. The 

values of heave roll and pitch can be selected with an 

user defined offset within the data window.  

Way Lines, Fix Lines, KP 

Lines, Cross Lines… 

Inserts vertical lines into the echo plot based on serval 

sources e.g. based on distance, KP’s, Fixes or 

predefined cross lines. 

Time Lines Inserts vertical lines into the echo plot after defined 

time periods. 

Manual Marker Lines Enables or disables the view of the markers in the 

active data window and shows a list of all markers. 

Insert Water Depth as 

Layer 

Calculates the water depths for the active data 

window. The user can edit some parameters for the 

calculation, like the sensitivity. 

Insert Seabed Multiples Calculates the multiple of a given layer and creates a 

new layer on the calculated horizon. 

Insert Sub-bottom Layer Calculates a sub-bottom layer based on a previously 

edited layer above. The user can edit some 

parameters for the calculation, like the sensitivity. 

Insert Layer from XYZ 

Grid File 

Calculates and shows a layer based on a XYZ grid 

file. 

Insert Layer with User 

Defined Parameter 

Calculate a layer based on property values of two 

other layers above and below. 
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Write Water Depth to 

Active Data File 

Overwrites the on-line calculated water depth or 

overwrites a SIS field with the calculated water depth 

from the active layer. 

Swell Filter Applies a software filter to echo data plots to remove 

heave ripples. 

Remove Seabed Multiples Applies a software filter to echo data plots to remove 

multiple echoes. 

Remove Ghost Echo Applies a software filter to remove echo signals 

caused by reflections which produce time shifted 

signals as an overlay to the main signal. 

Reduce Water Column 

Noise 

Applies a software filter to remove water column noise 

from the echo plot. 

Move Profile to Trackplot 

List1
Sets the active profile to the track plot window. 

Manipulate SIS Fields Interpolates or deletes selected SIS fields within a 

particular area.  

Save manipulated SIS to 

SES-File 

Saves the changes of the manipulated SIS fields and 

updates the track within the GIS module. 

View Tide Graph Shows the tide graph if there is a tide data file 

available. 

View SIS-Value Graph Shows a graph of the values of a selectable SIS Field. 

The ISE Extra Dialogs 

The File Information Dialog 

The file information dialog summarizes file specific information for the current data file. 

These include, for example, file and recording parameter and the current settings of 

the signal processing. 

1 Only visible in ISE releases without GIS extension module 
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The Palette Dialog 

The palette dialog can be used to select a suitable color palette for the current data 

window. The available color tables for *.ses data and *. raw data differs a little due to 

a different value range of the signals.  

The Signal Processing Dialog 

This dialog gives access to some settings of the Load Data Dialog. The appearance of 

the signal processing dialog varies depending on the current data file (raw-data, ses-

data). 
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The Ruler Lines Dialog 

The ruler lines dialog allows modifying the appearance of the horizontal depth or time 

lines. 

All settings made in the ruler lines dialog are valid for all subsequent loaded 

data files.  

The smallest distance between two ruler lines is one unit of selected units. 

The display of time lines will result in incorrect values, when the echo plot is 

corrected for different speed of sound values in the water column and the 

sediment body. 

• View 

Sets the base for the ruler lines. 

• No Ruler Lines disables the ruler lines. 

• Depth Lines displays ruler lines based on 

depth. 

• Time Lines (TWT) displays ruler lines based 

on two way travel time.[milliseconds] 

• Depth/Time Lines 

Automatic Mode Enables or disables the automatic for distance/interval 

calculation between the ruler lines. The 

distance/interval depends on the range of the echo 

plot. Large ranges causing more distance/bigger 

intervals for the ruler lines. 

Distances/Interval [ms] Sets either the distance or time interval between two 

ruler lines. 

Unit Sets the unit for the distance between two ruler lines. 

This is only enabled for Depth Lines. 



60     ISE 2.9 User’s Guide 

Innomar Technologie GmbH, October 2017 

• Options 

Without Labels Enables or disables the labels on the echo plot. 

Transparent Labels Enables or disables a transparent background for the 

labels. 

Draw Dashed Lines Draws dashed lines as ruler lines instead of 

continuous lines. 

Multiple Labels Enables or disables multiple labels at given distances 

in number of pings. If disabled, labels for the ruler 

lines will be displayed only at the beginning of the 

echo plot. 

The Motion Sensor Lines Dialog 

The recorded values from an attached motion sensor can be plotted as a curve on the 

echo plot.  

• View 

Offset of Zero Line [m] Sets an offset from the top of the window to display 

the motion sensor line. 

Draw Motion Sensor 

Line 

Enables or disables plotting the motion sensor line 

onto the echo plot. 

Draw Zero Line Enables or disables the zero line. 
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• Type 

Type Sets type of value to be displayed. 

The Way Lines, Fix, KP Lines, Cross Lines Dialog 

The dialog allows configuring and displaying vertical marker lines at regular distances. 

This is very useful in order to get an idea about the lateral dimensions in the echo plot. 

Different sources and possibilities are available to generate those vertical markers. 

Way lines are generated automatically based on a defined distance beginning from 

start of the echo plot. 

• Way Lines 

Draw Way Lines Enables or disables displaying way lines. 

Draw Way Numbers Enables or disables displaying way line labels. 

Transparent Labels Enables or disables transparent background for 

labels. 

Distance [way unit] Sets the distance between two way lines in way units. 

Way units depending on the selected SIS-IDs for x/y 

position during the file load. If a metric coordinate 

system was chosen the way unit is meter. When 

Lat/Lon was chosen the way unit is in degrees. 

Show Unit Enables or disables displaying the way unit next to the 

marker line. Sets also the desired unit. 

To obtain a better comparability between survey lines and different survey systems, 

way lines can be generated by logged KP or Fix values. KP’s also kilometer of 

pipeline gives a distance, with respect to the axis start point. Fix values are integer 

numbers such as event numbers which increase with ongoing survey. 
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• Fix Lines/KP Lines 

Draw Fix Marker Lines Enables or disables displaying Fix Marker lines based 

on the selected SIS-ID as source for the fix marker. 

Interval sets the interval for displaying the fix 

markers.  

Draw KP Marker Lines Enables or disables displaying KP Marker lines based 

on the selected SIS-ID as source for the KP marker. 

Distance [m] sets the distance in meter between the 

KP marker lines to be displayed. 

Extra Strings for Fix/KP 

Lines 

Enables or disables to add a string to the KP/Fix 

Marker line labels based on the selected SIS-ID as 

source for the string information. 

Transparent Label Enables or disables a transparent background for the 

labels. 

An event line will be displayed if the vessel’s track is crossing a defined line. A vertical 

line with the line name as annotation will be shown in the echo prints. As an example 

the segments of a pipeline could be entered, a cross line will be displayed always if 

the echo data crosses the pipeline. 

• Cross Lines 

Draw Marker on Cross 

Line Positions 

Enables or disables displaying cross lines.  

Draw Description Enables or disables displaying the cross line 

description label. 

Transparent Labels Enables or disables a transparent background for the 

labels. 

Cross Line Definitions Cross lines can be defined by entering a start and end 

coordinate into the corresponding fields on the way 

line dialog. Also a line name should be entered 

accordingly on the field list. 

Generates parallel lines to a selected line. 

Removes the selected line. 

Removes all lines. 

Loads a text file with the needed information and a 

space as delimiter.  

Saves the entered data in a text file. 
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The Add Line(s) Dialog 

This dialog appears if a line within the cross line definitions is highlighted and the Add 

Line(s) button was pressed. The dialog helps to generate parallel lines or 

perpendicular lines to the selected line. 

Number of Lines Sets the number of parallel lines to be calculated. 

Offset of Lines [+/-] Sets the distance between two parallel lines. It sets 

also the side for calculating the parallel lines. Positive 

values create lines to the right and negative values 

create lines on the left hand side of the selected line.  

Add perpendicular lines Enables or disables to calculate perpendicular lines to 

the selected line. 

Length of Lines [+/-] Sets length for the perpendicular lines to each side.  



64     ISE 2.9 User’s Guide 

Innomar Technologie GmbH, October 2017 

The Time Lines Dialog 

Within this dialog it is possible to define a time period for drawing vertical lines onto 

the echo plot. 

• View 

Draw Time Lines Enables or disables displaying time lines in relation to 

the start of the file onto the echo plot. 

Draw Time Numbers Enables or disables displaying labels to the time 

marker. 

Transparent Labels Enables or disables a transparent background for the 

labels. 

Interval [seconds]  Sets the time interval for displaying the marker lines. 

• GPS Time Lines 

Draw GPS Time Lines Enables or disables displaying time lines based on 

recorded time values e.g. from a GPS receiver. 

Transparent Labels Enables or disables a transparent background for the 

labels. 

SIS-ID GPS Time Sets the SIS-ID as source for the time. 

Interval [Seconds] Sets the time interval for displaying the marker lines. 

Time Format Sets the time format according to the recorded time. 

The Manual Marker Lines Dialog 

This dialog shows a list of all manual markers in the active data window which were 

set during the data acquisition. The list contains the echo number, the marker ID and 

the time. 
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• View 

Draw Marker Lines Enables or disables displaying manual marker onto 

the echo plot. 

The Insert Water Depth As Layer Dialog 

The water depth dialog sets the parameter for the automatic seabed layer detection. 

The layer will be created on the active layer. The selected layer should be empty in 

order to avoid overwriting layer segments.  

• Parameter 

Sensitivity Sets the amplitude level as a threshold for the layer 

detection. A low value results in a higher sensitivity. 

This not only leads in more accurate layer detection 

but also to the increased occurrence of spikes.  

For getting good results different settings 

could be tested. Default value here is 20-30%.

Smoothing Sets the number of values to be used for smoothing 

the layer. Smoothing will decrease the fluctuation 

within the calculated layer. 

Smoothing the seabed layer line should be 

done after removing spikes and outliers. 

Offset from Top Defines a blanked area for the depth calculation 

beginning from the top. This avoids spikes due to air 

bubbles around the transducer which can be seen as 

high amplitudes on top of the data window. The offset 

can be set in Pixel, meter or centimeter.

• Options 

Marked Block Only Enables or disables the calculation of a layer for a 

selected area. 
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Keep Layer Data Enables or disables keeping previously edited layer 

segments during the calculation. 

The calculation process will remove all layer 

segments on the active layer as long this 

option is not activated.  

Multiple Segments Divides the layer in segments according to the 

selected segment length. 

Use Water Depth from 

File 

Enables or disables the use of the online water depth 

in order to support the offline calculation algorithm.  

Search Band [+/-] Sets the size of the search band around the online 

water depth. 

• Buttons 

Starts the calculation of the seabed layer with the 

selected parameters. 

Insert the seabed layer based on the water depth 

calculation during the data acquisition. (on-line water 

depth) 

Insert the seabed layer based on values recorded on 

a SIS-ID. This will open an additional dialog.  

The Water Depth from SIS Field Dialog 

SES systems which have a multi-purpose input port are able to receive the water 

depth from another device e.g. Multi-beam system. Those received depth values are 

stored on a SIS field and can also be used to create the seabed layer. 

• Options 

SIS-ID with Depth 

Values 

Sets the SIS-ID as source for the external depth 

information. 

Displays the current assignment of the SIS-ID fields. 
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Negate Depth Values Negates the depth values coming from the selected 

SIS-ID. 

Factor for Sound 

Velocity Correction 

Sets a factor to compensate different speed of sound 

settings for the systems to match both depth values. 

Additional Depth Offset 

[+/- m] 

Sets a constant offset to compensate different draft 

settings for the systems to match both depth values. 

Depth Range Filter [m] Sets a range as a depth filter to remove spikes. 

The Insert Seabed Multiples Dialog 

For better interpretation and to avoid accidently digitizing multiples as real layer the 

tool makes multiples as layer visible.  

• Seabed Layer 

Layer with Depth 

Information 

Sets the layer number with the seabed information. 

• Target Layer for Seabed Multiples 

Insert 1st Multiple to 

Layer 

Enable or disables inserting the 1st multiple as layer 

line on the selected layer number.  

Insert 2nd Multiple to 

Layer  

Enable or disables inserting the 2nd multiple as layer 

line on the selected layer number. 
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The Insert Sub-bottom Layer Dialog 

This function inserts a layer to active layer and is very similar to the insert water depth

function. In contrast to the water depth determination the algorithm starts searching 

from already digitized layer and not from the top of the data window. The success of 

this calculation is mostly depending on the type and quality of the echo data. Usually a 

manually editing with the capture mode is required, but if there are very distinct 

layers within the data, then this processing function may be used. 

• Parameter 

Sensitivity Sets the amplitude level as a threshold for the layer 

detection. A low value results in a higher sensitivity. 

This not only leads in more accurate layer detection 

but also to the increased occurrence of spikes.  

For getting good results different settings 

could be tested. Default value here is 50%. 

Smoothing Sets the number of values to be used for smoothing 

the layer. Smoothing will decrease the fluctuation 

within the calculated layer. 

Smoothing the seabed layer line should be 

done after removing spikes and outliers. 

Upper Layer or Seabed 

Layer 

Sets the layer number as source for the upper layer. 

The search algorithm starts below the selected layer. 

• Options 

Additional Offset to 

Upper Layer 

Defines a blanked area for the layer calculation 

beginning from the upper layer. The offset can be set 

in Pixel, meter or centimeter.

Marked Block Only Enables or disables the calculation of a layer for a 

selected area. 

Keep Layer Data Enables or disables keeping previously edited layer 

segments during the calculation. 

The calculation process will remove all layer 

segments on the active layer as long this 

option is not activated.  

Multiple Segments Divides the layer in segments according to the 

selected segment length. 
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The Insert Layer from XYZ Grid File Dialog 

This tool allows inserting a layer from a xyz grid file and is working for SES-Files only. 

• Options 

Grid File Selects the grid file with the x, y, z information.  

Write to Layer Number Sets the layer number to create the layer. 

Maximum distance from 

Profile 

Sets the maximum distance away from SES data for 

accepting the point from the grid file. 

Skip search after first 

value is found 

Enables or disables search for further points after the 

first point which matches to the settings is found. 

Z-Multiplier Sets a factor to compensate different speed of sound 

settings for the systems to match both depth values. 

Z-Offset Constant Adds a constant offset to the Z-values (transducer 

draft or any vertical offsets) 

The Insert Layer with User Defined Parameter Dialog 

This dialog allows the calculation of a layer in between two existing layers. Assuming 

two layers (or one layer and the water depth) were digitized and some kind of 

parameter can be applied to each layer (for example a density value), then this tool 

can calculate the position of a given value between those two layers. This is based on 

a linear change of the parameters. All the positions of the given parameters are 

connected to build a separate layer, which will be drawn onto the echo plot. 
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The Write Water Depth To Active Data File Dialog 

Once a water depth was digitized and exists as a layer within the data window, this 

dialog allows writing that information directly to the according data file. It will replace 

the on-line calculated water depth.  

The online calculated values will be lost in this case and cannot be recovered. 

Optionally the information can be written to the one of the SIS fields. 

• Write Options 

Write Depth to SIS Sets the SIS-ID to write the depth values.  

The content of the selected SIS-ID will be 

overwritten! 

Delete SIS string if no 

depth available 

Enables or disables deleting the content of the 

selected SIS-ID if no depth value, due to interrupted 

layer, is available. 

Overwrite on-line 

calculated water depth 

Enables or disables replacing the on-line calculated 

water depth. 

Overwrite all Data 

Channels 

Enables or disables all data channels to be 

overwritten. 

SES data files contain more than one channel 

(e.g. HF and LF) the digitized depth can be 

written individually to each channel or can be 

used for all channels. 

• Side Scan Options 

This option is only available if the data file is a side scan data file. 

Write Depth to Selects the side to write the depth values. Either the 

active side or both sides. 
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The Swell Filter Dialog 

The swell filter can help to remove heave from the echo data if no motion sensor was 

used during the survey. This filter allows a software swell compensation and needs 

digitized cleaned bathymetry saved as separated layer. 

Be aware, that the software swell filter may remove not only heave ripples 

from the data, but real ripples on the seabed as well. Therefore a motion 

sensor with heave output is preferred and it is recommended to use the 

heave correction in advance of the swell correction. 

Swell Filter for SES Data 

• Motion Sensor 

Heave Correction Enables or disables the heave correction. 

Apply Heave Factor Applies a factor for the heave values to increase or 

decrease the amplitude of the heave data. 

• Swell Filter Settings 

Use Swell Filter Enables or disables the swell filter. 

Filter Length Sets the filter length. The filter length depends on the 

period of the swell and ping rate. In general long filter 

length will remove long swell and a short filter length 

will remove short swell ripples.  

Layer with Water Depth Allows choosing one layer to be the bathymetry layer. 

Change Water Depth 

Layer 

Enables or disables changing the bathymetry layer in 

order to match the echo data after filtering. 

Backup Water Depth 

Layer 

Enables or disables backing up the bathymetry layer. 

If the option Change Water Depth Layer was 

used, it is recommended to back-up the 

original bathymetry to another layer. Since the 

swell filtering is not stored in the data files and 

needs to be recalculated whenever a data file 

is reloaded. The origin bathymetry layer can 

be used to apply the swell filter again. If the 

data file is saved as processed data, the swell 

filter will be saved within the data file. 

Layer for Backup Sets the layer number for the layer back up.  
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Swell Filter for RAW Data 

The swell filter dialog for raw data differs a little compared to the ses data dialog. The 

swell filter for raw data demands a clean bathymetry saved within the data. In order to 

write the cleaned seabed layer back into the data, the Write Water Depth to Active 

Data File can be used.  

• Motion Sensor 

Heave Correction Enables or disables the heave correction. 

Apply Heave Factor Applies a factor for the heave values to increase or 

decrease the amplitude of the heave data. 

• Swell Filter Settings 

Apply Swell Filter Enables or disables the swell filter. 

Strength [%] Sets the filter strength.  

The swell filter is a low-pass filter, uses the online 

water depths to determine the frequency of the swell. 

Higher value will fit better to the lower swell 

frequencies (longer waves) and lower value will fit 

better to the higher swell frequencies.     
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The Remove Seabed Multiples Dialog 

This dialog works with raw data only and is only available when raw data is loaded. 

The filter removes unwanted signal parts from an echo plot caused by multipath signal 

propagation also called multiples. The condition for the optimal function is a clean 

online water depth. In order to save the cleaned seabed layer back into the data, the 

Write Water Depth to Active Data File can be used. 

• Settings 

Apply Multiples 

Reduction 

Enables or disables the multiples reduction. 

Reduction [%] Sets the reduction of the amplitude values of the 

multiples in percent.  

The Remove Ghost Echo Dialog 

The Ghost Filter dialog gives the possibility to remove signal parts from an echo plot, 

which are caused by reflectors within the sound propagation path. Such signal parts 

have nearly the same echo curve, but with a time delay. For example a parallel echo 

below the seabed will be visible on an echo plot. This function is only working for SES 

data. 

• Settings 

Remove Ghost Echo Enables or disables the ghost echo reduction. 

Ghost Echo 

Strength[%] 

Sets the approximate signal strength of the ghost 

echo in percentage of the primary echo. 

Ghost Echo Offset [m] Sets the offset of the ghost echo to the real echo. 

The more accurate the offset of the parallel 

reflection is given, the better the filter will 

remove the unwanted ghost echo. 
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The Reduce Water Column Noise Dialog 

This function helps to reduce or remove the noise within the water column. The 

condition for the optimal function is a clean online water depth. In order to save the 

cleaned seabed layer back into the data, the Write Water Depth to Active Data File

can be used. 

• Settings 

Apply Noise Reduction Enables or disables the water column noise reduction.

Noise Reduction [%] Sets the reduction level in percentage.  

The Manipulate SIS Fields Dialog 

With this function it is possible to edit the content of the SIS fields for a particular area. 

This makes it possible for example to remove GPS outliers. To identify such outliers 

the file needs to be loaded with the Track/GIS window. This function is only available 

when the data file was loaded with no Stacking, no Smoothing and no Track 

Accumulation. Moreover the tool does not work with multi frequency and beam 

steering data files. If all conditions are met, the tool is activated by marking an area 

with the Mark Block tool. The changes won’t be saved automatically and need to be 

saved by Save manipulated SIS to SES-File. 

Be aware, the tool will modify the SIS-IDs directly. No back up file will be 

generated. Once the changes are saved the SIS-IDs cannot be recovered. If 

the manipulation went wrong for some reason, it is possible to close the file 

and to discard the processing by not saving. 
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• Settings and Options 

SIS-IDs Enables or disables the desired SIS-IDs to be 

manipulated. 

Delete SIS data of 

selected area 

Deletes the content of the selected SIS-IDs for the 

marked area. 

Interpolate SIS data of 

selected area 

Interpolates the content of the selected SIS-IDs for 

marked area. 

The interpolation is only working for metric 

values. It doesn’t interpolate Lat/Lon or time. 

The View Tide Graph Dialog 

This is more a status window than a dialog. If the data file was loaded together with a 

tide file, the tidal curve will be displayed in the window. When the tide file consists of 

more than one day the desired day can be selected by the pull down box. It’s useful to 

verify the tidal curve for outliers.  

• Tide Graph 

Date Sets the desired date for displaying the tide curve, if a 

multi-day tide file was loaded.  
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The View SIS-Value Graph Dialog 

This window allows the representation of the individual SIS fields in a chart with 

respect to the pings. This is a quick method to check the SIS fields for outlier. The 

window responds to mouse interactions. The content of the chart can be moved in all 

direction by holding down the right mouse button while moving the mouse. There is 

also a zoom capability. Zoom in will be activated by holding down the left mouse 

button while drawing a rectangle from left to right over the point of interest. Zoom out 

will be activated when drawing the rectangle from the right to left. 

• SIS-Value Graph 

SIS Field No Sets the SIS-ID for displaying the graph. 

Use of Zero-Values Enables or disables filtering out zero numbers. 
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Probes Menu 

This menu gives access to the sediment probe data base and the sound velocity 

profile. The probe data can be edited, loaded and saved to a disk and also combined 

with a layer data in the open windows. The Probes Menu contains the following 

commands: 

Command Description 

Sound Velocity Profile Opens the dialog for the input and activation of a 

sound velocity profile. 

Correct Echo Plot with 

Sound Velocity Profile 

Corrects the echo plot and active layer in an open 

data window with a given sound velocity profile. 

Numerical Profiles Opens the Editor for the numerical profile data base. 

Overlay Echo Plot with 

Numerical Profiles 

Enables the overlay of numerical profiles on the actual 

data window with different options. 

Sediment Probes Opens the Editor for the sediment probe data base. 

Overlay Echo Plot with 

Sediment Probes 

Enables the overlay of sediment probe data on the 

actual data window with different options. 

Overlay Target Positions  Enables the overlay of manual marker lines provided 

by a text file 

The ISE Probes Dialogs 

The Sound Velocity Probe Dialog 

This dialog allows the definition of a sound velocity profile to correct the water column 

for sound velocity which is valid for the whole application. It can be used in any open 

data window. For each meter, starting at -1m, a value can be defined. Each field is 

manually accessible. Fields with no data in between will be interpolated automatically 

after activation. From the last entered value till the end of the table the values are 

constant. That is also valid for the beginning of the table, when the values do not start 

from -1 meter. 

• Sound Velocity Profile 

Opens a standard Windows® open dialog to choose a 

sound velocity file. The file format can be found in the 

appendix under The Sound Velocity File Format.  

Opens a standard Windows® save dialog to save the 

entered sound velocity profile. The default file 

extension will be *.svp. 

Clears the whole sound velocity table and the sound 

velocity probe becomes inactive.  
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Fills down the whole table with the value from the 

marked cell. 

Fills up the whole table with the value from the 

marked cell. 

Activates the sound velocity profile to correct the SBP 

data.  

That will not apply the correction to the SBP 

data yet. That will be done by Correct Echo 

Plot with Sound Velocity Profile.  

Cancels modifying the sound velocity profile and 

closes the dialog. 

Depth Range Sets the depth ranges for the sound velocity chart. 

SVP Range Sets the sound velocity ranges for the chart.  

• Options 

Save Positive Depth 

Values 

Writes positive depth values when the sound velocity 

data is saved to a file. 

The Correct Echo Plot with Sound Velocity Profile Dialog 

Once a sound velocity profile is defined and activated, the correction needs to be 

enabled. While the upper part of the dialog refers to sound velocity correction for the 

water column, the lower part deals with the sound velocity correction for the sediment 

body. This is useful to get corrected echo plots with more accurate depth and 

thickness of sediment layers because the speed of sound inside the sediment is 

usually different than in the water column. 
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• Water Depth 

Layer with Water Depth Sets the layer for the seabed information. This is 

needed to define the border between water column 

and sub-bottom data. 

• Correction Parameters 

Apply SVP Correction Enables or disables the SVP correction for the water 

column for the data window. 

Change Water Depth 

Layer 

Enables or disables adjusting the seabed layer 

according to the sound velocity profile. 

Backup Water Depth 

Layer 

Holds the original seabed layer on a selected layer 

number. Since the corrected echo data is not saved, 

the echo plot needs to be recalculated, whenever the 

SES data file is reloaded. 

Layer for Backup Sets the layer number to back up the original seabed 

layer when the option is enabled. 

• Sediment 

Apply Correction for 

Sediment 

Enables or disables a sound velocity correction for the 

sediment body.  

Change Sediment 

Layers 

Enables or disables adjusting the sub-bottom layers 

according to the sound velocity for the sediment body. 

Speed of Sound of 

Sediment 

Sets the speed of sound for the sediment body. 
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The Numerical Profiles Dialog 

Numerical profiles can be done in many ways. Each kind of measurement connected 

to a depth value can be overlaid to the echo plots. An example would be a density 

profile. This dialog allows to import and to modify the numerical profile data base. 

Once the database is activated, it can be used for all loaded data files.  

Loads a collection of numerical profiles within a 

numerical data file *.den.  

Saves the collection of all numerical profiles within the 

profile list to one data file. It results in a binary file with 

*.den as file extension. This file can be reloaded by 

the Load function. 

Clears the whole dialog. It removes all loaded 

numerical profiles. 

Closes the dialog and exits. 

• Profiles 

Adds single or multiple ASCII text files including the 

numerical profile data according to the desired file 

format. The file format can be found within the 

appendix under The Numerical Profile File Format. 

Deletes selected numerical profiles from the list view.  

• Properties 

Short Name (5 

Characters) 

Sets or edits the probe name. 

Position X Sets or edits the x position of a selected numerical 

profile. 

Position Y Sets or edits the y position of a selected numerical 

profile. 

Number of Numerical 

Values 

Sets or edits the number of numerical values within a 

selected numerical profile. 

Ground Level [m] Sets the ground level for the selected numerical 

profile. 

Online Water Depth as 

Ground Level 

Enables or disables the usage of the online water 

depth as ground level for the selected numerical 

profile. 
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Enables or disables the usage of the online water 

depth as ground level for all numerical profile. 

The Overlay Numerical Profiles Dialog 

Once a numerical profile data base is edited and activated, the information can be 

combined with echo plots. 

• View 

Draw Numerical 

Profiles 

Enables or disables overlaying the numerical profiles 

onto the echo plots. 

Maximum Distance 

from Profile 

When overlaying the sediment probes with echo plot, 

this allows to set the maximum distance to exclude all 

numerical profiles which are outside that distance.  

• Drawing Mode 

Vertical lines only Draws only a vertical line at the position of the 

numerical profile. 

Complete Numerical 

Profile as Curve 

Draws all values of the numerical profile as a curve 

diagram onto the echo plot. 

Complete Numerical 

Profile as Bar Graph 

Draws all values of the numerical profile as bar 

diagram onto the echo plot. 

Complete Numerical 

Profile as Colored Bar 

Draws all values of the numerical profile as colored 

bar diagram onto the echo plot. 

• Options 

Numerical Value of 

Center Line 

Sets a value of the numerical profile as a cross point for 

the vertical marker line. 

Scale factor Sets a scale factor to adjust the appearance of the 

numerical curve or bar diagram. 
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Show probe name Enables or disables displaying probe name onto the 

echo plot. 

Show probe distance Enables or disables displaying the distance of probe to 

the echo data. 

Show Min and Max of 

Profiles 

Enables or disables displaying the minimum and 

maximum value of the numerical profile onto the echo 

data. 

Data Range for Colored 

Bar 

Sets the data range for the colored bar diagram.  

The Sediment Probes Dialog 

The main function of this dialog is the editing of the sediment probe data base. This 

data base is application wide accessible. 

Imports sediment probes as an ASCII text file. The file 

format can be checked under The Sediment Probe 

File Format.

Loads a sediment probe data base. This is a binary 

file with *.sed as file extension.   

Saves all sediment probes to a single file. This will 

create a new file with *.sed as file extension.  

Clears the sediment probe data base. 
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Closes the sediment probes dialog. That will not clear 

the sediment probe data base. 

• Probes 

The list view shows all sediment samples of the data base.  

Adds a new sample to the data base. 

Deletes selected samples within the list view from the 

data base. 

• Properties 

Short Name 

(5 Characters)  

Specifies or edits the selected probe name. 

Description Specifies or edits a short description of the selected 

probe. 

Date and Time Specifies or edits the date and the time of the 

selected sediment probe.  

Position X Specifies or edits the X-Positon of the selected 

sediment probe. 

Position Y Specifies or edits the Y-Positon of the selected 

sediment probe. 

Ground Level [m] Specifies or edits the ground level for the selected 

sediment probe. The ground level must be entered as 

a negative value. 

Online Water Depth as 

Ground Level 

Enables or disables the using of the online water 

depth as ground level for the selected sediment 

profile. 

• Sediment Layer 

Adds a new sample/layer to the selected sediment 

probe. An input mask Edit Sediment Layer will be 

opened.  

Deletes a sample/layer of the selected sediment 

probe. 

Edits a selected sample/layer of the selected 

sediment probe. An input mask Edit Sediment Layer

will be opened. 
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The Sediment Layer Input Mask 

• Properties 

Depth of Layer below 

Ground Level [m] 

Shows the depth of the current sample/layer below 

the seabed. The depth of each layer will be calculated 

automatically depending on the probes ground level 

and on the thickness of the upper layers. The depth 

will be updated if a single layer is deleted. 

Layer Thickness [m] Specifies or edits the sample/layer thickness in meter. 

In order to create a new sample/layer, the value must 

be specified. 

User Defined Property 

1-5 

Variable fields for entering further properties such as 

density, granularity or SPT values. 

Description Variable field for entering a description of the 

sample/layer. 

Color Specifies a color for the sample/layer. That will open 

an additional window to select the color. 

Pattern Specifies pattern for the sample/layer. That will open 

an additional window to select the pattern. The pattern 

list follows the standard sediment classification 

symbol set of the British Style. 
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The Overlay Sediment Probes Dialog 

Once a sediment probe data base is edited and activated, the information can be 

combined with echo plots.  

• View 

Draw Sediment Probes Enables or disables overlaying the sediment probes 

onto the echo plots. The overlay can be switched on 

or off for each data window separately. 

Maximum Distance 

from Profile 

Sets a maximum distance to exclude all sediment 

probes outside for overlay.  

• Drawing Mode 

Vertical lines only Draws only a vertical line at the position of the 

sediment probe. 

Complete Sediment 

Probe 

Draws the complete sediment probe like a colored bar 

with the soil patterns. 

• Options 

Show probe name Enables or disables displaying the sediment probe 

name onto the echo plots. 

Show probe distance Enables or disables displaying the distance of the 

sediment probe to the echo data. 

Show ground level Enables or disables displaying the ground level of the 

sediment probe onto the echo plots. 
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The Overlay Target Positions Dialog 

There are many types of targets, such as points of interest, cross points with other 

profiles or probe locations. A target can be at any position which is selectable on the 

echo plot. In order to overlay targets onto the echo plot, an ASCII text file with the 

information is needed. This text file can be created manually with a text editor or 

automatically by some functions of ISE software such as Calculate Cross Points

from the GIS module.  

Loads an ASCII data file with the target information. 

The file format can be looked under The Target File 

Format. 

Clears all targets from the list.  

• Options 

Show Targets 

Maximum Distance 

from Profile 

Enables or disables displaying of the loaded targets. 

Sets a maximum distance, after which targets are 

excluded from the view. 

Show Target Distance 

from Profile 

Enables or disables displaying the distance of the 

target to the echo data. 

Show Coordinates Enables or disables displaying the coordinates of the 

target. 

Show Targets ID’s Enables or disables displaying the target IDs. 

Show Target 

Information 

Enables or disables displaying the target information. 

Show additional 

Window with matched 

Targets 

Opens an additional window that lists all of the targets 

which are located in the current data file. 
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Options Menu 

This menu gives access to the different tools of the ISE application, like the zoom box 

or the track plot window. The Options Menu contains the following commands: 

Command Description 

Toolboxes Configures which tool box window should be visible 

on the screen. 

Environment Configures some application wide options. 

The ISE Option Dialogs 

The ISE application has some useful tools for special handling or views in a separate 

window respectively box. These boxes can be opened even though no data are loaded, 

but in this case not all functionalities are available. The positions of these small tool 

boxes are saved, which means they will always appear at the same position they were 

closed. According to this and under the condition that multiple screens were used, it is 

possible that the wanted tool box doesn’t appear, which is caused because of this tool 

box lies outside of the current available screen. 

The Toolbox Dialog 

This dialog allows the selection of the tool boxes which shall be displayed. Every tool 

box can be separately enabled or disabled. The available tool boxes are listed under 

the section of The Ise Tool Bars and Status Bars. 

Bring to Front Sets the current selected tool box of the dialog to the 

foreground, sets the focus on it and closes this dialog. 
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The Tool Box 

This tool box can be used to show additional specific information for two coordinates. 

If the selected points are not in the same window the calculation is also 

possible. This is useful to measure distances between features in different data 

files. 

Set If it is pressed the mouse cursor changes to an arrow. 

The point of concern which is then selected into the 

data window will be put into the tool box. After the 

selection of two points, the differences in all 

directions, the distance on the flat plane and distance 

in three dimensions, the course or direction, the slope 

angle and the slope steepness in percentage will be 

calculated. 

Is only enabled if a data window is available. 

Use Projected 

Coordinates 

If it is checked, the data files are side scan files, the 

water depth is processed and a true heading source is 

chosen then the true distance between the selected 

projected data points (offset from track applied) below 

the water depth ground line will be calculated. 
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The Zoom Tool Box 

This tool box gives a zoomed view around the cursor. It is updated immediately when 

the mouse is moving over the echo plot. Three different zoom levels and two zoom 

window sizes are selectable. The box is useful for accurate layer or target editing. 

The Overview Tool Box 

This resizable tool box window gives an overview of the total echo plot, even if it 

exceeds the screen size. The visible part on the computer screen is highlighted. By 

dragging with the mouse the highlighted section can be changed to navigate within 

the echo plot. 

The Gis/Track Box Tool Box 

When the GIS extension is available, an access is permitted to more powerful tool 

which allows several views and manipulations, which can be saved. For instance it is 

possible to show tracks, side scan coverage, profile crossing or depth views. Without 

the GIS extension only a simplified track window version is available to show the 

tracks of the loaded profiles. 

The actual position of the cursor in the active data window is marked with a small 

cross into the tool box view field. To get more information view the section How to 

work with the GIS module. 



90     ISE 2.9 User’s Guide 

Innomar Technologie GmbH, October 2017 

The File Menu 

Open Data Files Opens The GIS Map View Loading Dialog echo data 

loading dialog. 

Open Background Open a Windows® browser dialog to load an image 

file which is used as image for the background 

The image file should match the area of the 

loaded data else the view won’t be helpful. 

Export Tracks Opens a Windows® browser dialog to export the X 

and Y coordinate positions and dependent on the 

target file type may the water depth of all loaded files 

in the order they are loaded and listed at the right in 

the Map Layer under Tracks. 

Export Map View Opens a Windows® browser dialog to export the 

current map view as an image. 

Exit If no profile is loaded the GIS Map View will be 

closed. 

• The Gis Map View Loading Dialog 

Directory Browser Selects single or multiple files. 

X Position in file This is the SIS-ID which contains the X coordinates of 

the positions of the files data. 

Y Position in file This is the SIS-ID which contains the Y coordinates of 

the positions of the files data. 

Heading Source Determines whether the SIS-ID or the motion sensor 

is assigned as the source for the heading angle, 

which is needed for data files containing side scan 

channels and to calculate a coverage map. 

Coordinate System This is the coordinate system in which the positions of 

the selected files were recorded and have to be 

shown in. Choose between projected and geographic 

systems. 

The GIS Extension supports more than 4000 

coordinate systems and it is possible to create 

user defined coordinate systems. 

SES-2000 data files may contain an EPSG code 

already. In such case the Open Data dialogue 

will ask the user to apply this stored coordinate 

system. 
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The Map Menu 

These functionalities are used to interact with the graphical view of the loaded data. 

Select Mode The closest track to the clicked point will be selected 

and highlighted 

Drag Mode Reposition the view field by moving the mouse during 

the left mouse button is pressed 

Measure Mode Calculates the distance between two set points which 

can be gained with the pressed left mouse button 

Only available if an EPSG code is selected. 

The measure bar with distance value remains 

active until a second measurement is performed 

or the mode is switched. 

Zoom Selection Mode Zooms into the selected region if the region start 

corner lies left and above the region end corner, 

otherwise zooms out 

Zooming can be done easy by the mouse wheel. 

Zoom In/Out Performs zoom action 

Zoom Full Extent Zooms to the full view extent for all loaded tracks 

Zoom to previous Extent Reset the zoom to the last extent before the latest 

mouse wheel usage, after adding tracks, backgrounds 

or other objects to the Map View 

Delete All Erases all loaded profiles and background images 
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The GIS Functions Menu 

Show Depth Colours If it is toggled on, the colors chosen in the Options 

dialog of the GIS Functions menu will be given to the 

depth values of the profile files. 

Show Side Scan 

Coverage

If it is toggled and side scan profiles are loaded the 

projected coverage of this data are shown 

Export Voxler Data Allows exporting SES or RAW data into a binary point 

cloud based on a predefined raster. The exported 

point clouds can be used to calculate voxels by the 

Innomar Gridder software. That voxel information can 

be visualized as a 3D model in a 3rd party software 

such as Avizio or Voxler. The function is available for 

licenses with Innomar Gridder software permission 

only. 

Options Opens the GIS map options dialog 

Set Coordinate System Opens a dialog to choose between three possibilities. 

If one EPSG code is set during the loading of the files 

this EPSG code can be changed but only for viewing.  

The third option is to turn off the geographic 

interpretation but as a result the distance 

measurement will be unavailable. 

Calculate Track Cross 

Points

Calculates all cross points of the loaded profiles and 

assign numbers to them with: Ta#:# 

• The Export Voxler Data Dialog 

Upper left corner [X/Y] Sets the coordinates of the upper left corner for the 

entire area by entering manual or either by clicking   

the pick button followed by clicking the point in the 

map.  

Area geometry [X/Y] Sets the number of tiles in x and y direction.  

Area size [X/Y] Sets the size of each tile. 

Updates the GIS Map in order to visualize the chosen 

number of tiles and size. If the arrangement does not 

meet the requirements, these can be adapted and can 

be checked by pressing the button again.

Select Voxler-Export-

Script 

The pull down list provides the available scripts to 

export the data.  

Starts the selected script for the export. Only visible 

survey tracks will be exported. Depending on the 

export settings binary or text files for each tile will be 
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created. The according tile number is added to each 

filename. Additionally a dxf file with all tiles is created. 

Stops the definition of tiles and closes the dialog 

window. If the script is already started the Cancel 

button will not interrupt the script. 

• The GIS Map Options Dialog 

Depth Color Table Defines colors for different ranges in meter 

representing the depth values of the files which are 

used if the Show Depth Colors option is enabled. 

Once assigned colors for the chosen range may not 

be suitable for another loaded file with different range. 

Therefore these colors can be adjusted. 

Channel with depth 

data 

Selects the HF or LF channel as source for the depth 

data 

Automatic depth bands 

from file 

If it is checked, then the depth range of all files will be 

automatically determined and applied. Unless under 

User depth range the depth range will be manually 

selected. 

User depth range [m] Defines a range where the colors for the depth data 

are assigned to 
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The GIS Tool Bar 

The buttons from tool bar have the same functionalities as described above in the 

menus, but there is one exception - the Open selected Track button. Icons for a fast 

referencing are the same as well. 

Open selected Track If it is checked The Load Data Dialog will occur to 

load this data file into the data window 

The Map Layer 

This panel shows the content of the view and allows several changes for the loaded 

background images, the loaded echo data or available objects. 

• Background 

If this tick box is checked all loaded and ticked background images are shown with 

their settings on the map. The right mouse button click opens a popup menu which 

allows the removing of the current background image. Further the transparency of 

the current background image can be adjusted. 

• Grid 

If this tick box is checked the grid lines and/or the grid points are shown on the 

map. 

• Tracks 

If this tick box is checked all loaded and ticked echo data files are shown on the 

map. The right mouse button click opens a popup menu with the following options. 

Open Echo Plot If it is checked The Load Data Dialog will occur to 

load this data file into the data window. 

Remove from Map If it is checked the loaded file will be removed from 

the map view. 

Show Info Columns The selected columns will be shown behind the file 

name, which is presented on the tree list view. 
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• Objects 

If this tick box is checked all objects of all loaded and ticked echo data files are 

shown on the map. The right mouse button click opens the same popup menu as 

described under Tracks. The loaded track file will be moved from Tracks to here.

The Target Picker Tool Box 

This tool can be used to digitize single reflectors from the echo data. It summarizes all 

digitized single reflectors and creates a database. In addition, digitized reflectors are 

highlighted in the echo data. Reflectors can be added to the database from any data 

file. 

It is recommended to use the Target Picker Tool only with interpolated 

coordinates to avoid offsets in position due to different update rates of the 

sensors.  

• Pick Target 

Allows picking a single reflector within the echo plot. 

The reflector is marked by a downwards looking 

triangle, a number and a dashed vertical line. The 

position (x,y,z) is filled into the according fields next 

to the button. 

Allows picking the seabed in order to calculate the 

distance between reflector and seabed. The z-value 

of the seabed and the distance between reflector and 

seabed is filled into the according fields next to the 

button. The fields can be left empty.  
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Picks the position on the left hand side of the 

reflector and fills the values into the according fields 

next to the button. The fields can be left empty. 

Picks the positon on right hand side of the reflector 

and fills the values into the according fields next to 

the button. If both sides are picked, the dimensions 

can be calculated and are filled into the field 

accordingly. Fields can be left empty. 

Next ID Shows the next coming ID for the reflector, if 

increase automatic is checked. 

ID-Value Specifies a manual ID for the reflector. This number, 

if used, is also shown next to the reflector marker. 

The field can be left empty. 

Comment Specifies a user comment to the reflector. The field 

can be left empty. 

Quality Sets a quality tag for the target. 

Create Picture of Target 

Area 

Enables or disables creating a picture of the area 

around the target. The picture size is selectable from 

the pull down list. The selected size of the picture is 

shown as dashed line on the echo plot. 

• Target List 

It adds the content of the text fields from Pick Target

to the list and completes the SIS-IDs records for that 

point. Furthermore the average amplitude of 

reflector, average amplitude of the seabed and the 

ratio is given. Name of the file from which the 

reflector was digitized and the name of the image 

file, if it was created, are attached to the list. The 

placeholder for empty fields is a minus. Thus the 

number of columns is constant. (30) 

Removes a selected row from the list. 

Removes all entries from the list. 

Loads an existing list to continue them. 

Saves all entries of the list to an ASCII text file. 

Saves all entries of the list to a certain ASCII text file. 
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The Segment Tool Box 

This tool box contains a list of all edited layer segments. During the edit process 

different segments are created. Selecting one segment in the Segment Tool Box 

highlights this segment in the active data window. Each segment can be deleted from 

the list and therefore also from the layer in the data window. Additionally it’s possible 

to pick a single segment with a left mouse button click via the button Pick Segment. 

Delete Segment If it is pressed all selected segments will be deleted 

from the list and the data window. 

Pick Segment If it is pressed the mouse cursor changes to an arrow. 

The closest segment to the mouse cursor position of 

the data window will be selected by the left mouse 

button click then. 

Is only enabled if a data window is available. 

The Environment Dialog 

Within this dialog it is possible to set up some options for the application itself. This 

will be done in a global manner. 

• Application 

Save window positions 

on Exit 

If it is checked all positions and settings regarding the 

visibility of the application window and the tool 

windows will be saved when the ISE is closed. 

These settings will be restored during the next start of 

the ISE. 
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Propose file names 

automatically 

If it is checked the file name proposals, based on the 

names of the loaded data files, will be done for 

several functions and operations automatically. This 

may help to find a suitable name. 

Confirm before deleting 

a layer 

If it is checked a confirmation is necessary before a 

layer is deleted. 

Confirm layer changes 

before closing window 

If it is checked a confirmation for changes on layers is 

necessary before an opened data window is closed. 

Use File Selector when 

loading data and layer 

files 

If it is checked the ISE File Selector will be used as 

file selecting dialog instead of the common Microsoft®

Windows®. 

• Data Windows View 

Show all SIS Strings If it is checked the data window status bar has a 

second line with all SIS strings of the ping at the 

cursor position. 

Otherwise only the first line is viewable with the 

general information of the ping at the cursor position. 

• Data Windows Default Layer Properties 

Global options for the created data windows. Local changes out of these data 

windows won’t influence these settings. Settings can be saved and loaded for the 

global as well as for local options. 

No. Specifies for the other settings actual layer from 1 to 

20. 

Name Specifies the default name of the current layer. 

It is used during export of files and for better 

orientation during processing. 
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Color Specifies a color for the layer as described under Pen 

Dialogs. 

Pen Opens a settings dialog for the layer as described 

under Pen Dialogs. 

Use default properties 

when loading layer files 

If it is checked the default layer properties will be used 

for generated layer 

If a layer is with different stored layer properties is 

loaded, the default values will replace the loaded 

settings. 

Default Layer for Depth 

Values 

Specifies the layer between 1 and 20 where the depth 

values are written in as default. 
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Tools Menu 

The Tools Menu allows choosing different tools for separate tasks, which are not 

directly attached to a data window but sometimes very useful. For instance, there is a 

tool for editing of the profile information of the data files available. Another tool can be 

used to generate a list of profiles of the whole contents of a directory. The Tools Menu 

contains the following commands: 

Command Description 

Profile Number Editor Starts a tool for the manipulation of the 

profile number, the ship name, the travel 

name and the area name in a data file. 

Profile List Generates a list of all profiles in a 

directory. 

SIS Extract Starts a tool for the extraction of SIS 

strings into ASCII data files. 

SIS Replace Starts a tool for the replacement of SIS 

strings in data files with SIS strings in an 

external text file. 

SIS Process Starts a tool for several functions 

regarding coordinate processing and 

processing of the SIS fields, e.g. 

interpolation, clipping, offsets, course 

calculation. 

Coordinate Transformation Starts a tool for coordinate trans-

formation. 

Motion Processing Starts a tool to apply or modify lever arm 

corrections. 

Layer Combination Tool Combines two ASCII layer files and 

calculates the difference between them. 

Antenna Offset Tool Starts a tool for the calculation of the 

position offset if during the recording the 

GPS antenna was not directly mounted 

above the transducer (processes ASCII 

files). 

Decimate Text Files Decimates text files with tables, for 

instance exported x, y, z files, by 

removing lines. 

Add Text Files Combines two or more text files to one 

target file. 
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Comma Point Editor Switches between comma and 

semicolon in ASCII files, which is 

sometimes useful for data exports. 

Filename Editor Changes the file name of a data file 

between short and extended style and 

allows systematic file name 

modifications. 

Add Data Files Combines two or more echo data files to 

one target file. 

Cut Data Files Cut echo data files and create new data 

files with regions of interest or to remove 

unimportant parts. 

Reduce RAW Files Reduces the range length of a RAW data 

file. 

Convert SES3 Files Converts SES3 files into RAW data files. 

Tide File Converter Converts from Hypack exported tide 

correction files into Innomar tide files.  

Process Script A scripting tool to apply various 

processing steps to a number of data 

files successively e.g. load data file and 

calculate water depth. 

The ISE Tools Dialogs 

Some tools are included in the ISE software package which are not directly involved in 

the edit process but are sometimes very useful. They can be started even though no 

data window is open. 

Tools work directly with the files on the disk, so be careful because the data 

will be modified irreversible. Always make data backups prior to processing. 

The Profile Number Editor 

With this editor it is possible to edit the general file information of SES-2000 data files. 

If a file is selected in the file list, the actual contents are shown and can be changed 

by pushing the Replace button. 

Directory Browser Selects single or multiple files. 

• Settings 

Ship Name Name of the ship of the selected file. 

Travel Name Name of the travel of the selected file. 



102     ISE 2.9 User’s Guide 

Innomar Technologie GmbH, October 2017 

Area Name Name of the area of the selected file. 

Profile Number Profile number of the selected file. 

• Options 

Use a prefix to 

generate new files 

A prefix can be used to generate new files to avoid 

overwriting the existing files. 

The Profile List Tool 

With this tool it is possible to generate a list of selected profiles from a directory. The 

profile list is an ASCII file within the same directory and is written file by file in the 

order listed below under Data Fields. 

Directory Browser Selects single or multiple files. 

List File Name of the output file inclusive the extension. 

• Data Fields for File List 

File Type Type of the selected files. 

Date/Time Gives the date and time of the selected files creation. 

Profile Profile number of the selected files. 

File Name Name of the selected files. 

Frequency Frequency of the selected files. 

Recording Range Range value of the selected files. 

Area Area of the selected files. 

Travel Travel of the selected files. 

Start/Stop values of 

SES strings for the IDs 

1 to 8 

The first and the last string entries of the selected 

SIS-IDs ordered ascending with all start entries 

followed by the end entries. 

Preview SIS… Opens a preview window which shows the start and 

the end string entries for all SIS-IDs of the first 
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selected file. 

• Options 

Insert Header into File 

List  

Writes a headline into the output file of the selected 

contents. 

Delimiter The delimiter sign between the entries are: 

 Space, Comma, Semicolon, Tabulator. 

The Extract SIS Tool 

The tool extracts strings of the selected SIS-IDs with or without additional data entries. 

The SIS data are recorded into ASCII files within the same directory with a white 

space character as delimiter between every entry. The created files have the same 

filenames as the source files with an optional prefix and file extension ‘.txt’. The 

additional data entries into the output file are arranged in the same way as the check 

boxes and tabs. 

Directory Browser Selects single or multiple files. 

Use a prefix to generate 

new files 

A prefix can be used to generate new files to avoid 

overwriting already existing files. 

Preview SIS… Opens a preview window which shows the start and 

the end string entries for all SIS-IDs of the first 

selected file. 
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• Extract 

SIS-String ID 1 to 8 String entries of the selected SIS-IDs in ascending 

order. 

• Additional (Data Columns) 

Append Motion Sensor 

Data (R, P, Y, H, Heave 

[mm]) 

Motion sensor data entries belonging to the SIS entry 

(only if available): 

Roll, Pitch, Yaw and Heading angle; Heave values in 

millimeter 

Append on-line 

calculated water depth 

Belonging to the SIS entry on-line water depth, 

presented as negative values in meter with the 

optional check boxes: 

Multiplier for depth values: Multiplies the water 

depth by the entered value to convert into another 

metric system or to negate the negative sign. 

Constant offset for depth values: Adds the entered 

value to the water depth. 

Append PC Date and 

Time 

Date and time of the control computer belonging to 

the SIS entry. 

Append Ping Number Ping number belonging to the SIS entry. 
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• Options 

The check boxes will be added to the first data entry line only. This might be useful 

for some labelling functions in external software packages. 

Profile Number in the 

first row 

Profile number of the corresponding file. 

Travel Description in 

the first row 

Travel description string of the corresponding file. 

Area Description in the 

first row 

Area description string of the corresponding file. 

Extract conditional 

amount of data 

Only entries will be extracted which fulfill the chosen 

condition: 

-none-: Only entries which differentiate to the last 

extracted entry. 

Extract SIS for event marker only: Only entries 

which have an event marker. 

Extract SIS for time interval only: Only one entry 

every chosen interval. 

Extract SIS for every ping: An entry for every ping. 

The Replace SIS Tool 

The tool is developed for the replacement of any data recorded on the SIS-IDs. In 

order to use this replace function, it is necessary to provide a corresponding time base 

for synchronization such as GPS time. The tabs of ‘Input Data’ and ‘Replace’ contain 

the essential settings for the replacement process whereas the tabs ‘Data Gaps’ and 

‘Options’ contain only optionally and auxiliary settings. The number of enabled set up 

controls of ‘Data Gaps’ and ‘Replace’ depends on the number of columns, available 

within the text file. 

Data gaps have two origins. The first case is when no time stamps for the 

synchronization are available. The second case is if time stamps are available but the 

value for replacement are missing. 
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Only entries of the SES files where a valid time synchronization entry is 

available will be overwritten. If for any of these entries no data entries of the 

SIS text file are available, where these data entries are the called data gaps 

too with gaps where no time stamp is available, then these gaps can lead to 

unwanted results. Such gaps might be generated due to removing position 

outliers. 

To prevent unwanted behavior the avoidance of setting the same target SIS-

ID of the SES files is advisable for multiple columns of the SIS text file. 

Directory Browser Selects single or multiple files 

Use a prefix to generate 

new files 

A prefix can be used to generate new files to avoid 

overwriting the existing files. 

Preview SIS… Opens a preview window which shows the start and 

the end string entries for all SIS-IDs of the first 

selected file. 

• Input Data 

The time string format can be differ from the format inside the SES data files. 

SIS-ID in SES data file 

with time for 

synchronization 

Used only if Use PC-Time is unchecked 

Means the SIS-ID of the SES files where data entries 

for the time based synchronization can be found. 

Use PC-Time Use the time from the control computer for the 

synchronization. 

Select text file with new 

SIS data 

Field has to hold the absolute path together with the 

name of an ASCII text file. This SIS file, with up to 

eight usable columns, has to contain the 

synchronization data and the data entries for the 

substitution. All columns are separated by single white 

space, tabulator or comma characters. 

A heading line isn’t allowed!  

This would lead to none column entry to be 

found. 

First row of the SIS text file must represent the 

correct number of columns otherwise not all 

columns or more columns than actually exist, will 

be found.  

Column in SES file with 

time for synchronization

Specifies the column of the text file where data entries 

for the time based synchronization can be found. 
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• Data Gaps 

Handle Column x from 

SIS file as 

where x is a digit 1 to 8 

Following options have the interpretation meanings for 

the interpolation: 

metric: Interpret column entries as metric entries 

heading: Interpret column entries as heading angle 

-skip-: Don’t interpolate gaps of this  

Interpolation of data 

gaps within the Input 

SIS file 

If it is checked up to seven of the first eight columns’ 

possible existing data gaps can be interpolated before 

these entries replace any entries of the SES files. The 

column which is used for the time based 

synchronization won’t be available. 

• Replace 

Column x from SIS file 

to SIS-ID 1 to 8 

where x is a digit 1 to 8 

Tells which SIS fields with the IDs 1 to 8 of the SES 

files have to be replaced by the actual column of the 

SIS text file. All with -none- selected or disabled 

columns of the SIS text file will be ignored. 

If more than one column is set to the same SIS-

ID of the SES files then the entries of the highest 

column number will be the result. 

Be careful not to overwrite the synchronization string 
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in the SES file if it is needed for further processing 

steps within this tool. 

If any SIS-ID of the SES files is replaced by the time 

based synchronization field of the SIS text file and the 

interpolation is checked then the interpolated entries 

of the time are in decimal format. That means whether 

another format is used for the time into the SIS text 

file this values are written to the chosen SIS-ID of the 

SES files in the given format, which may be different 

from the decimal format because of using delimiter 

signs like colons, whereas the interpolated values are 

written into the decimal format. This leads to 

inconsistent entries at the chosen SIS-ID of the SES 

files. 

• Options 

Delete SIS data in SES 

file if new SIS strings 

are not available 

If this option is checked without interpolation then any 

SIS-ID string entry of the SES files which belongs to a 

data gap will be empty. 

Preview After the Check button is pressed the preview shows 

the under ‘Input Data’ entered time based 

synchronization entries of the SES files and the SIS 

text file, which reveals data gaps and overlapping.  
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The SIS Process Tool 

The tool allows several operations to process or manipulate SIS data entries within a 

SES data file. Every function has its own tab and is executed by pressing the present 

button of the tab. 

Overwriting the original data within SIS fields may become irreversible. 

Therefore a backup is strongly recommended. 

Directory Browser Selects single or multiple files 

Use a prefix to generate 

new files 

A prefix can be used to generate new files to avoid 

overwriting the existing files. 

Preview SIS… Opens a preview window which shows the start and 

the end string entries for all SIS-IDs of the first 

selected file 

• Interpolate Single SIS 

Interpolate the data of the chosen SIS-IDs linearly. Each SIS-ID will be interpolated 

for its own without being influenced by other data of another SIS-ID. 

SIS ID 1 to 8 Set one of the following data interpretation for the 

wanted SIS-IDs: 

metric: Interpret SIS strings as metric entries 

heading: Interpret SIS strings as heading angle 

time: Interpret SIS strings as time values of common 

format which uses the delimiter colon or dot;; is not 

to use for pure decimal digit based time entries, 

therefore the metric option has to be chosen 

-skip-: Don’t interpolate the SIS strings 

digits Means the resulting number of digits behind the 

decimal delimiter separate for every SIS-ID 
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• Interpolate Coordinates 

Interpolate the data of the chosen SIS-IDs linearly, but only if the value at the X 

and the Y position changes. 

SIS ID x-Position 

where x represents the 

coordinate direction 

X, Y or Z 

Assign a SIS-ID to the coordinate position. This is 

optionally in case of Z direction. 

Decimal Digits Means the resulting number of digits behind the 

decimal delimiter for all coordinate directions 

• Manipulate Coordinates 

Change the data entries of the chosen SIS-ID, which are interpreted as decimal 

digits if nothing else will be specified. 

SIS ID The SIS-ID which shall be modified 

Multiplier Multiply all data entries by this defined factor 

Offset Add this offset to all data entries 

If the data entries are of time format this offset 

will be interpreted as seconds. 
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Data are angles 

(0°…360°) 

If is checked all data entries will be interpreted as 

angles between 0 and 360 degree 

Data are time strings If is checked all data entries will be interpreted as time 

formatted strings. 

Decimal Digits The result digit number behind the decimal delimiter 

Trim to zero Digits The result entries will be integer values 

• Combine SIS 

Combine the entries of two input SIS-IDs with a specified operation to a specified 

output SIS-ID. 

SIS ID #1 The SIS-ID as the left-hand side of the operator 

Operation The mathematical operation which shall be executed 

is one of the following: 

+: Add the second SIS-ID to the first SIS-ID 

-: Subtracts the second SIS-ID from the first SIS-ID 

*: Multiplies the first SIS-ID with the second SIS-ID 

/: Divides the first SIS-ID by the second SIS-ID, if 

the second value is zero the result will be set to zero 

SIS ID #2 The SIS-ID as the right-hand side of the operator 

Output SIS ID The SIS-ID where the result will be stored 

Decimal Digits The result digit number behind the decimal delimiter 

Skip Data Gaps (zero 

values) 

If is checked and one of the input SIS-IDs is zero the 

result will be zero 
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• Offset Coordinates 

Add an offset to chosen SIS-IDs entries which have to contain the position 

coordinate. The offset for the X and Y position will be processed together with a 

given heading angle to gain the corrected offsets for these both positions.  

SIS ID x-Position 

where x represents the 

coordinate direction 

X, Y or Z 

Assigns a SIS-ID to the X, Y or Z coordinate position. 

This is optionally in case of Z direction. 

x-Offset Transducer [x 

Unit] 

where x represents the  

X, Y or Z 

The offset which will be added to the X and Y 

coordinate positions dependent on the heading angle, 

whereas the offset for the Z position will be added to 

the Z Position as it is  

The offset unit have to be the same as the 

coordinate position where it will be added to 

Heading Source Specifies where to find the necessary heading angle: 

Motion Sensor: Use the internal saved heading 

angles delivered by a used motion sensor 

SIS ID x: Use the entries of the SIS-ID x where x is a 

digit from 1 to 8 as heading angle source 

Decimal Digits Means the resulting number of digits behind the 

decimal delimiter for all coordinate directions 

• Clip Coordinates 

Cut off all X and Y coordinate positions which don’t lie into the specified rectangle 

through erasing the string entries of them. 

SIS ID x-Position 

where x represents the 

coordinate direction 

X, Y 

Assigns a SIS-ID to the X or Y coordinate position. 

MinX, MaxX, 

MinY, MaxY 

Specifies an interval for the X Position and one for the 

Y Position  
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• Calculate Course 

Calculates a course with chosen input SIS-IDs entries which have to contain the 

position coordinate and store it to the specified output SIS-ID. Useful when no 

heading sensor was available to generate approximated heading angles. 

SIS ID x-Position 

where x represents the 

coordinate direction 

X, Y 

Assigns a SIS-ID to the X or Y coordinate position. 

SIS ID Course The SIS-ID where the result will be stored 

Decimal Digits The result digit number behind the decimal delimiter 

Average Course If is checked the calculated course may be more 

smoothed because of not using only the next change 

of the X and Y coordinate position but the following 

variation 

• Rotate Coordinates 

The function rotates the survey area around a certain point in order to reduce the 

amount of data during gridding and visualization. This will change the origin 

coordinates of the data files. In order to prevent overwriting the coordinates use a 

prefix to generate new files.  

SIS ID x-Position 

where x represents the 

coordinate direction 

X, Y 

Assigns a SIS-ID to the X or Y coordinate position. 

Rotation Point Sets the point in x and y for the rotation.  

Rotation Angle[°] Sets the rotation angle in degrees. Positive values will 

rotate the area counter clockwise.  
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• Filter SIS 

Filter the entries of the chosen SIS-ID with different filter options. One or multiple 

filter options have to be checked. The following listed filter options will be applied in 

the following listed order: ‘Median Filter (three elements)’, ‘Replace Steps with 

Zero’, ‘Moving Average Filter’ and ‘Average Filter (remove drifts)’. 

SIS ID The SIS-ID which shall be filtered 

Decimal Digits The result digit number behind the decimal delimiter 

Replace Steps with 

Zero 

If is checked all entries which are less respectively 

greater than the entry of the next entry subtracted 

respectively added by the under If Step Size >

specified range will be replaced by zero 

If Step Size > This entry specifies the maximal allowed variation 

Moving Average Filter If is checked for all entries an moving average filter 

with the under Filter Length specified filter length will 

be applied 

Filter Length This entry specifies the range of used entries for 

building an average value for the current entry

Median Filter (three 

elements) 

If is checked spikes will be removed through usage of 

a median filter over three elements 

Average Filter (remove 

drifts) 

If is checked drifts will be removed through applying 

an DC offset filter 

Data are angles 

(0°…360°) 

If is checked all data entries will be interpreted as 

angles between 0 and 360 degree 

Skip Data Gaps (zero 

values) 

If is checked then occurrences of data gaps will be 

interpreted as the last valid value else this gaps will 

be interpreted with zero 

Calculate mean value 

for entire file 

If is checked the average value for the selected SIS 

ID will be calculated. All origin values on this SIS field 

will be replaced by that average.   
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• Delete SIS 

Delete all entries of the chosen SIS-IDs respectively erases entries partially 

dependent on a condition. 

Delete selected SIS 

Fields depend on 

condition 

If is checked only entries of the pings which fulfil the 

condition will be erased 

The entries at these ping positions will be deleted for 

all chosen SIS-IDs 

Condition: 

SIS ID 

Select one SIS-ID of 1 to 8 on which the condition will 

be applied 

Condition: 

Comparison operator 

drop down box 

Specifies one of the following comparison operation: 

<: Less than the followed value 

>: Greater than the followed value 

=: Equal to the followed value 

<>: Unequal to the followed value 

Condition: 

Value field 

Specify the comparison value 

SIS-ID 1 to 8 If is checked the deletion will be executed for this SIS-

ID 

• Rearrange SIS 

Rearrange all chosen SIS-IDs entries to specified SIS-IDs. 

If multiple SIS-IDs have the same target SIS-ID then the resulting entries 

will be those of the SIS-ID with the highest number. 

SIS-ID x to If is checked an target SIS-ID have to be defined 
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where x is a digit 1 to 8 

• Delay SIS 

Shift all entries of all SIS-IDs by an offset. In which wise this happens depend on 

the mode which is at current state only the ping based. 

Mode The mode on which the delay shift is based: 

Ping Mode: Interpret the entered Offset Value as 

direct ping shift in positive or negative direction 

Offset Value Specifies the offset which is interpreted and applied 

dependent on the chosen mode 

Can be negative, for backward shift direction, 

respectively positive,  for forward shift direction, 

integer values 

Delete old Values If is checked the remaining entries of the pings which 

are shifted away but not replaced by new shifted 

values will be deleted otherwise this values remain at 

their original ping positions and may lead to confusion 

because these entries occur double  

The Coordinate Transformation Tool 

The tool allows the transformation of recorded LAT/LON positions to various metric 

coordinate systems. All available coordinate systems are listed by names and EPSG 

codes. More information about EPSG codes can be found under the internet link. The 

tool has the same appearance and functionality as within the SESWIN software. The 

transformation can be performed for *.ses as well as *.raw data files. 

Directory Browser Selects single or multiple files  

• Data Source and Destination 
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Positon Data Source SIS-IDs which contain LAT/LON coordinates and the 

corresponding hemisphere 

Position Data 

Destination 

SIS-IDs as destination for the transformed 

coordinates 

Input Format (WGS84) Specifies the data format of the recorded LAT/LON 

positions. Typically for GPS receivers is: 

DDDMM.MMMM  

Output Format Sets the desired output format: 

Projected Conversion transforms the LAT/LON 

position into a projected coordinate system. This 

requires additional settings on the Conversion 

Parameters tab.  

DDD.DDDDDD will perform a format conversion of 

LAT/LON 

Use a prefix to 

generate new files 

A prefix can be used to generate a new file to avoid 

overwriting the existing file. 

• Conversion Parameters 

Set projected 

Coordinate System 

Selects the destination coordinate system from the 

drop down list. 

In order to find the desired system faster, the 

keyboard can be used to enter the name. 

Determines the native meridian strip for the UTM 

transformation automatically  

Detailed Information about the transformation 

parameters 

Decimal Digits of 

Output 

Sets the number of decimal place for the output 

coordinate. 
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The Motion Processing Tool 

The Tool provides a lever arm correction during the post processing. A lever arm 

correction becomes necessary when the motion reference unit (MRU), which is here 

declared as motion sensor, is located on a different position than the transducer, 

which is here declared as monitoring point. 

Directory Browser Selects single or multiple files 

Use a prefix to generate 

new files 

A prefix can be used to generate a new filesfile to 

avoid overwriting already existing files. 

• Lever Arm processing 

As described at the ‘Lever Arm Geometry’ explanation layout the center of gravity 

has the abbreviation CG, the motion sensor has the abbreviation MS and the 

monitoring point has the abbreviation MP. The average filter will be executed 

before the high pass filter and are always executed after any processing is done if 

they are activated. 
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In the general manner it is unsuitable to try this heave correction if an 

online heave correction is already done with the correct entered roll angle 

or by used motion sensor. 

Offset from CG to 

Motion Sensor [m] 

Defines the x, y and z offset vector from the center of 

gravity (CG) to the motion sensor (MS). 

Offset from CG to 

Monitoring Point [m] 

Defines the x, y and z offset vector from the center of 

gravity (CG) to the monitoring point (MP). 

Restore unprocessed 

heave data 

If it is checked the lever arm correction won’t be 

executed, the unprocessed heave data are restored 

only. 

Not available for the deep sea mode, because 

the heave data are calculated with a recording 

delay which is no longer available. 

Add Roll/Pitch to delay 

to non-stabilized data 

If it is checked the lever arm correction won’t be 

executed. 

To correct an actual tilting of the MS, under the 

assumption that the sea ground is even and no online 

stabilizing was applied, it will correct wrong water 

depths which occur through a tilting angle conditioned 

wrong duration of the beam. 

This may improve the data quality but there’s no 

guarantee because there are a lot influencing 

factors to the heave itself and the heave 

influences the data only as one of many other 

factors. 

Apply heave factor If it is checked the old heave value will be multiplied 

by the entered factor before it’s changed through the 

calculated lever arm correction 

Apply average filter 

(remove drifts) 

If it is checked drifts will be removed through applying 

a DC offset filter. 

Apply high pass 

(remove drifts) 

If is checked drifts will be removed through applying a 

high pass filter with the specified high pass frequency, 

which have to be between zero and the sample rate. 

Apply Roll-Offset [°] If it is checked a roll offset will applied to correct the 

heave. 

It is added to the roll angle which was recorded during 

the acquisition process as a positive or negative offset 

angle. 

Copy Heave Value from If is checked the lever arm correction won’t be 
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SIS-ID executed, only the old values will be replaced by the 

values of the entries of the specified SIS-ID. 

• Import Motion Data from Text File 

The motion data import function allows importing reprocessed data from a motion 

reference unit such as heave, roll, pitch and heading. The basis for a successfully 

import is a correlating time for the SES2000 data and the MRU data. The motion 

data which were used during the survey will be overridden by the imported data.   

SIS-ID in SES/RAW 

data file with time for 

synchronization 

Used only if Use PC-Time is unchecked. 

Means the SIS-ID of the SES/RAW files where data 

entries for the time based synchronization can be 

found (GPS Time). 

Use PC-Time Use the time from the control computer for the 

synchronization. 

Select text file with new 

motion data 

Field has to hold the absolute path together with the 

name of an ASCII text file. This SIS file, with up to five 

usable columns, has to contain the synchronization 

data and the data entries for the substitution. All 

columns are separated by single white space, 

tabulator or comma characters. 

A heading line isn’t allowed! 

This would lead to none column entry to be 

found. First row of the SIS text file must 

represent the correct number of columns 

otherwise not all columns or more columns than 

actually exist, will be found. 

Column in motion data Specifies the column of the text file where data entries 
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file with time for 

synchronization 

for the time based synchronization can be found. 

Column in motion 

data…. 

Assign the columns according to the specific data 

such as heave, roll, pitch and heading.    

The Layer Combination Tool 

The tool combines two ASCII coded input layer text files where the chosen data from 

the first layer text file will be copied unchanged to the ASCII coded output layer text 

file supplemented by a processed Z coordinate position column. 

The coordinate positions X, Y, and Z have to be in this order at the first three 

column positions. The decimal separator has to be the dot and the delimiter 

between the columns entries have to be single white space characters. 

Source File A Absolute path to the first input text file 

Source File B Absolute path to the second input text file 

Output File C Absolute path to the output text file 

• Options 

The Z coordinate position values into the input text files can be positive or negative 

which influences directly the calculation result. 

The possibility to change the true distance, if it differs from the one of the Z 

coordinate position, by assuming different sound velocities to the both input 

files should be done only if this wasn’t already done before the layer were 

exported. 

Operation The mathematical operation for the Z coordinate 

position for the both input layer text files: 

Sub C=A-B: Subtract the Z values of file B from A 
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Add C=A+B: Add the Z values of file B to A 

Options If is not <none> positive, by selected Skip pos. 

Values, respectively negative, by selected Skip neg. 

Values, result data entries will be skipped 

Be careful with it! Dependent on the operation in 

combination with this option up to all result 

entries can be deleted. This option should be 

used if unwanted values of the second layer shall 

be erased which lie on the other not wanted side 

of the first layer values.  

Sound Velocity File A 

or B 

Determine the sound velocity value for the first input 

layer text file A respectively the second file B 

• Files 

Write XA, YA, DZ only If is checked only the X and Y coordinate positions of 

the first input file will be copied and the processed Z 

coordinate position will be added as third column 

If is unchecked the processed Z coordinate position 

values will be inserted as column behind the 

coordinate positions of X, Y and Z of the first input file 

followed by the other existing column entries of the 

first input file. 

The Antenna Offset Tool 

The tool correct the GPS antenna position coordinate of an ASCII coded text file by 

the specified offset for the X and Y coordinate position offset. This is useful if the GPS 

antenna was not mounted over the transducer. The delimiters of the text file have to 

be single white space characters. 
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It’s advisable to use this only if the for the correction calculated course 

represents the heading direction of the vessel. Otherwise the specified offsets 

can’t be used for the correction in a correct manner.  

Directory Browser Selects a single text file 

Number of Columns Specify the number of available columns between 2 

and 12 

Columns above this number will be erased out of 

the text file. 

Column X or Y Specify the columns where the X respectively the Y 

coordinate position is stored 

These columns will be overwritten with the 

corrected values if nothing else will be specified. 

Ensure a different column index for X and Y and 

ensure that they are less equal the specified 

number of columns. 

X- or Y-Offset [m] Specifies the positive or negative offset for the X 

respectively the Y coodinate position in meters 

Smooth Course If is checked the for the coordinate correction 

necessary calculated course will be smoothed 

Ignore Course Changes > 

90° 

If is checked occurrences of calculated course 

changes from one coordinate to the next greater than 

90 degree won’t be smoothed 

Add Corrected Positions If is checked the processed corrected coodinate 

position entries will be added at the end of the file 

instead of being substituted 

Add Calculated Course If is checked the for the calculation needed course 

data will be added at the end of the file in degrees 

Use Tabulator as Delimiter If is checked the used delimiter of the to the file 

written columns will be the tabulator else it will be 

single white space characters 
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The Text File Decimator Tool 

The tool decreases the amount of rows of the selected ASCII coded text files. 

Directory Browser Selects single or multiple files 

Use a prefix to generate 

new files 

A prefix can be used to generate new files to avoid 

overwriting already existing files. 

• Decimate 

Define the condition which has to be fulfilled by the rows which shall be deleted. 

Delete Rows based on 

Percentage [%] 

If is checked a percentage value between 10 and 90 

is specified where only every nth row dependent on 

this value will be kept 

Delete Rows based on 

Coordinates [distance] 

If is checked a distance is specified where every entry 

will be kept only whose distance to the last kept value 

is greater to this specified distance 

Delete Rows based on 

Coordinates [area] 

If is checked an area through entering the minimum 

and maximum coordinate boundaries is specified 

where all entries are kept only which lie outside of this 



ISE 2.9 User’s Guide     125

Innomar Technologie GmbH, October 2017 

are 

Number of Columns in 

Text File 

Specify the number of available columns between 2 

and 12 

Columns above this number will be erased out of 

the text file 

Column with X- or Y-

Coordinate 

Specify the columns where the X respectively the Y 

coordinate position is stored 

Ensure a different column index for X and Y and 

ensure that they are less equal the specified 

number of columns. 

• Option 

Keep lines with 

START/END in Coda 

and Pipe-Files 

If is checked the for these formats necessary START 

and corresponding END tags will be kept 
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The Add Text Files Tool 

The tool combines all selected ASCII coded text files file by file into a new output file. 

Directory Browser Selects single (senseless here) or multiple files 

Name of new file Have to contain the name of the output file inclusive 

the extension 

An empty field will lead to abort the process 

Insert clear lines If is checked an empty line will be added between the 

single files entry parts of the output file 

The Comma Point Editor 

The tool allows the exchange of dot and comma entries of all selected ASCII coded 

text files. 

Directory Browser Selects single or multiple files 

comma --> point If is selected all occurrences of commas into the files 
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will be exchanged by dots 

point --> comma If is selected all occurrences of dots into the files will 

be exchanged by commas 

swap <--> If is selected all occurrences of dots into the files will 

be exchanged by commas and all occurrences of 

commas will be exchanged by dots 

The File Name Editor 

The tool allows the renaming of file names in different manners. 

Directory Browser Selects single or multiple files 

• Extend File Names 

Load a text file which contains the file names, inclusive the file extension which 

shall be renamed respectively added by the specified naming, and the 

corresponding new names for the files, exclusive the file extension. 

File with extended 

string information 

Absolute path to the ASCII coded text file which 

contains the file names and the new names for every 

file in an extra line 

The delimiter for the naming tuple has to be a single 

white space character 
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Additional prefix to file 

name string extension 

If is checked the entered prefix will be added to all 

files’ specified new names of the text file 

Delete original file 

name string 

If is checked the old file names, without the file 

extension, of the selected files will be substituted by 

the specified new names of the text file 

If is unchecked the new names will be inserted 

between the old names and the file extensions 

• Long/Short Conversion 

Selected SES files naming can be modified. 

long --> short If is selected the selected files will be shortened to 8 

characters concatenated with the file extension 

Takes the first 4 characters and 4 characters from the 

9th to the 12th sign of the old file name 

short --> long If is selected the selected files will be shortened 

respectively expanded to 12 characters concatenated 

with the file extension 

Takes the first 4 characters of the old file name, 

concatenated with the year of the file, concatenated 

with 4 characters from the 5th to the 8th sign of the old 

file name and concatenated with the seconds of the 

file 
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The Add Data Files Tool 

The tool concatenates the entries of the selected SES-2000 or RAW files together into 

one output file. This might be useful because of limited resource management during 

the recording process one profile could be split into multiple files but which shall be 

processed together. The selected files will be concatenated in the order as they are 

displayed into the browser list. 

Add only compatible files to one target file because otherwise the processing 

can fail. For instance it isn’t possible to process files with different range 

lengths or files with different beam steering settings or with different multi 

frequency settings. Also a mix of beam steering and multi frequency data will 

not be processed correctly. 

The addition of the files isn’t limited by the size. However, if the file size is 

bigger than 100 MB, the working speed becomes slow. It’s advisable to limit 

the file size to an optimum for the processing workstation.  

Directory Browser Selects single (senseless here) or multiple files 

Name of Combined File Have to contain the name of the output file inclusive 

the extension 

Choose automatically If is checked a suggestion for an output file name will 

be offered dependent on the selected files 
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The Cut Data Files Tool (deprecated) 

The tool works as the inverse tool of The Add Data Files Tool and trim a selected 

SES-2000 or RAW file of a specified section of defined boundaries. This tool has been 

replaced by the Export Marked Section as SES/RAW-File….  

The new created file has to have a different file name as the selected one. 

Otherwise the tool won’t work in a correct manner. This have to be done after 

the Cut button has been pressed. 

Directory Browser Selects a single file 

• File Cut 

The boundaries for the section to which the file shall be trimmed to, can be set 

through specifying them with the preview field or with the edit fields. The rainbow 

colored section represents the remaining section whereas the inverted rainbow 

colored sections will be cut off. 

Zoom drop down box Specifies the zoom ratio for the preview field and 

influences the viewable ping precision with it which 

changes the scope of the file’s data 

For a ping wise precision the zoom 1:1 have to 

be chosen, otherwise the selected section 

boundaries will be multiplied by the first digit of 

the zoom ratio to gain the true chosen ping 

positions for the trimming. 

Changing the zoom after already entered the 

boundaries will erase these settings. 

From Pos. Contains the lower trimming section boundary 

Can only be changed if the arrow button on the right 

side of this field is toggled 

To Pos. Contains the upper trimming section boundary 

Can only be changed if the arrow button on the right 

side of this field is toggled 
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The Reduce RAW Files Tool 

The tool cuts off the data of the selected RAW files which lie into the specified range. 

The specified range cuts off from the end of the file’s range. 

Directory Browser Selects single or multiple files 

Reduce range length from 

begin of file [m] 

Specifies the range which shall be cut off from the 

begin of total range in meter 

Reduce range length from 

end of file [m] 

Specifies the range which shall be cut off from the 

total range’s end in meter 
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The Convert SES3 Files Tool 

The tool converts SES3 data files into multiple RAW data files. 

Directory Browser Selects single or multiple SES3 files and informs with 

the remarks whether navigation offset (NO) or lever 

arm correction (LA) was already applied to the data. 

Exit Leaves the SES3 file converter 

• General Settings 

These settings determine the transducer build type with essential spacing 

information and other settings for interpolation and correction calculations. 

Interpolate Coordinates 

based on Time Stamp 

Interpolates the coordinates. The SIS-IDs for the x 

and y position are required. The SIS-ID for z position 

is optional as well as the SIS-ID for the heading 

whereas the heading is required if Navigation 

Offsets have to be calculated. 

The option to use the heading from the motion sensor 

excludes the SIS-ID usage. 

Transducer spacing The used spacing depends on the selected array 

configuration mode. 

Use online transducer 

spacings 

If it is checked, the online spacing is written  into the 

file and used, instead of the entered und Transduce 

spacing

Array configuration Selects a configuration of the Quattro array where the 

view is from top: 

Quad/Triple Beam Mode (QBM/QBMW/TBM) 

- Quad Beam Mode (QBM) 

- Quad Beam Mode Wide (QBMW) 

- Triple Beam Mode (TBM) 

Dual Beam Mode (DBM) 

Single Beam Mode (SBM) 

The transducer spacing is essential for the 

conversion. Value to be entered depends on the 

selected mode and is shown in the picture. The red 

dot marks the transducer array center point. 
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• Navigation Offsets 

Only has to be set for files for which the navigation offset was not already set 

online. 

Online Settings Informs about the state of the selected files. If the 

selected files have different state then convert only all 

files of one type to avoid applying correction of files 

which already have online navigation offset set or to 

avoid to skip the files which missing it. 

Antenna Offset to Array 

Reference Point 

The correction offsets in x, y and z direction according 

to the sketch shown in field Geometry. 
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• Motion sensor 

Only has to be set for files for which the lever arm correction was not already 

applied online. 

Online Settings Informs about the state of the selected files. If the 

selected files has different state then convert only all 

files of one type to avoid applying correction of files 

which already have lever arm correction set or to 

avoid to skip the files which missing it.  

Lever arm settings The correction offsets in x, y and z direction according 

to the sketch shown in field Lever Arm Geometry. 

The upper row defines the offset from the center of 

gravity to the motion sensor. 

The lower row defines the offset from the center of 

gravity to the monitoring point where the transducer is 

fitted. 

Look at the geometry sketch to ensure entering 

the correct positive and negative offsets for the 

corresponding axes. 

• Motion sensor special options 

Restore unprocessed 

heave first 

If it is checked the lever arm correction will be 

executed after the unprocessed heave data are 

restored. 

Apply heave factor If it is checked the old heave value will be multiplied 

by the entered factor before it’s changed through the 

calculated lever arm correction. 

Apply Roll-Offset [°] If it is checked a roll offset will be applied to correct 

the heave. 

It is added to the roll angle which was recorded during 

the acquisition process as a positive or negative offset 

angle. 
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Apply average filter 

(remove drifts) 

If it is checked drifts will be removed through applying 

a DC offset filter. 
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• Conversion 

Summary Settings Informs about done settings which will applied to the 

selected files during conversion. 

Conversion of file Informs which file currently is converted. 

File progress Informs about the conversion state of the current 

converted file. 

Total progress Informs about the total progress of the conversion of 

all selected files. 

Convert Starts the conversion process. 

Cancel Cancels the conversion at the current converted file. 

The Tide File Converter Tool 

Exported tide files from Hypack (*.tid) contain tide correction values instead of real 

tide values. To be able to use these files with ISE software it is necessary to convert 

them into Innomar Tide Files (*.itid). The tide file name has to contain the date in the 

following manner:   *ddmmyyyy.tid  

If the file name does not contain the date in the correct format, the tool will not 

work. 

Directory Browser Selects single or multiple *.tid and informs with the 

remarks when the file name is not in the correct 

format.  

Exit Leaves the tide file converter. 
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• Conversion Parameter 

Scale tide values by 

factor 

This is the multiplication factor to convert the tide 

correction values into tide values. Default: -1 

Shift tide values 

[minutes] 

Applies time offsets to tide file to compensate different 

time zones.  

Average tide values 

[minutes] 

Smooth the tide values by averaging the values based 

on time.  

Preview Show the tide correction values in comparison to the 

resulting tide values. 

• Conversion Parameter 

Convert Executes the conversion 
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The Process Script Tool 

The tool executes a command sequence file for selected SES-2000 or RAW files, 

which are simply called ‘script files’. This is useful if the same procedure shall be done 

for multiple files and shall not be done explicitly for each file for its own. 

• Script File 

The selected script sequence with the selected files can be saved into a script file 

and loaded again if it’s wanted to process the files again in that wise. 

Name Absolute path of the current loaded script 

Contains isescript.scr if no script is loaded 

New Generates a new script file for the current settings and 

selected files which can be saved if it’s wanted 

Load Loads an existing script file 

Save Saves the current file 

Overwrites an opened file or saves as if a new file is 

generated 

• Editor 

The editor field contains the script text which will be executed. It can be modified 

directly, which is useful to delete parts which may no longer wanted if the script is 

loaded and shall be executed in a partially changed manner. 

Command The command sequence which shall be executed for 

the selected files 

Parameter Specifies what the list below have to contain for the 

command sequence execution: 

<FILENAME>: Absolute path of a file 

Insert Opens a browser dialog to select files 

Adds to the current selected command sequence files 

for which these sequences will be executed 

Use HF depth…. Enables or disables the use of the water depth layer 

saved in the height frequency channel.  

Apply water column 

noise reduction… 

Enable or disables the reduce water column noise 

function to the files to be processed. (The Reduce 

Water Column Noise Dialog)  

Apply SVP…. Enables or disables the sound velocity correction for 

the files to be processed. (The Sound Velocity Probe 

Dialog)  
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Export processed… Enables or disables exporting processed data files 

with the applied settings as processed raw or ses 

files. (The Export Processed SES/RAW-File Dialog) 

Close each data… Enables or disables closing the files after processing 

in order to prevent computer memory overflow. 

The Voxler Output Settings Dialog 

The dialog occurs during exportation of voxel output data. 

• Options 

File Format Binary or ASCII text file. 

Range Offset Defines which type of offset will be used. 

- absolute: define a range beginning from water 

surface 

- relative: define a range with offsets for start and 

end of the existing range 

- seabed: start from seabed and define absolute 

end 

All values are defined in centimeter (cm). 

Output Depth Scaling Defines a multiplication factor for the vertical values. 

Stacking Data in Z 

Direction 

Enable or disable the stacking in z direction which 

means dividing the vertical data amount by factor two. 
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Window Menu 
The Window Menu contains commands for the arrangement of the open data 

windows on the screen. These are the common arrangements from the Windows® 

environment, like cascade and tile. The Windows® Menu contains the following 

commands: 

Command Description 

Cascade Arranges all open data windows in the application 

space in a cascaded style, starting on the upper left 

corner. 

Tile Vertical Arranges all open data windows vertically, so that the 

whole application space will be shared between the 

windows. 

Tile Horizontal Arranges all open data windows horizontally so that 

the whole application space will be shared between 

the windows. 

Arrange Icons Arranges all data window icons in the application 

space. 

Minimize All Minimizes all open data windows to icons. 

Close All Closes all open SES files. 

Help Menu 

Command Description 

Check for Update Opens the Update Dialog Box. 

About Shows the About Box with the software version 

information and the software registration data. 
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The ISE Help Dialogs 

There is one dialog for update checking and an information box. 

The Check for Update Dialog 

Opens a dialog where information about the below listed contents are displayed: 

• The current version of the ISE software  

• The license and dongle number of the current active dongle 

• Whether the Innomar server is accessible 

• Which version of the ISE software is the latest 

Close Closes the dialog 

Release Notes Opens an information window listing the most recent 

changes into the ISE software 

Send Request Is available if a newer version of the ISE software 

exists 

Opens and prepare an html e-mail to Innomar to get 

the newest version of the software 

The About Box 

Opens a dialog, which contains several information as licensing. 
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How to use… 

This section contains typical operation procedures for various tasks and the description 

of the use of the Processing Software Package ISE. Based on different applications 

and the recorded data sets some steps for the processing will be described in detail. 

One should read all paragraphs because some procedures, for instance the generation 

of a profile list or the load procedure, are valid for most applications, but described only 

once.  

How to change the Load Data Dialog appearance  

In order to facilitate the opening of data files, there are two different dialogues 

available. The first dialog is the standard Windows® file open dialog in which the 

appearance and functionality (haptic) is Windows® conform. The second one is more 

adapted to the special needs of opening *.ses or rather *.raw data. This custom made 

open dialog is giving more detailed information for each data file. Another difference is 

that the last opened data file remains highlighted. That is a big advantage if many 

data files must be opened successively. In order to switch in between the both 

variants, the Environment Options need to be adjusted.  

① Enables or disables the Innomar custom made open dialog.  
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How to change layer names and set pen properties for each layer 

For a better presentation and distinction digitized layers with different colors and pen 

width can be displayed. It can also be set individual name for each of the 20 layers. All 

these can be done within the Environment Options. 

① Brings the data window of the environment dialog to front. 

② Selects the number of the layer to be renamed. 

③ Text field for entering the layer name. 

④ Opens a standard color dialog in order to choose a color from. 

⑤ Opens a dialog in order to set a certain pen width for the layer. Also a 

certain drawing mode is selectable. (Freehand, Lines or Polygons) 

⑥ Confirms and applies the settings to the actual data file and to all 

following opened data files.  

How to generate bathymetry data from SES-2000 profiles 

The insert water depth function can be found either under Extra → Insert Water 

Depth as Layer…  or can be selected from the icon (when hovering above any 

icon the description is visible), with tag Calculate Depth. 

Before digitizing the bathymetry a few notices should be considered.  

• The bathymetry is typically taken from the HF channel. The loading of 

the different data channels is described in the section The loading of data 

Files. 
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• The resolution of the bathymetry depends on the selected stacking 

factor during the digitization and on the position update rate during the 

data acquisition. To achieve a good depth data density it is important to 

work with interpolated data files. The interpolation of positions can be 

found under the section Interpolation. Also influencing the data resolution 

is the stacking factor. The following example shows the influence of the 

stacking factor. The picture on the left hand side shows the seabed layer 

with stacking factor 20, the right hand side shows the same layer with 

stacking factor 2. The difference is clearly visible the digitized seabed 

layer does not fit to the real seabed. The stacking factor can be changed 

in the Signal Processing Dialog. 

Once the HF channel of an interpolated data file is opened the depth calculation 

dialog can be opened. 

① A suitable parameter for the sensitivity can be from 20 to 30%. 

② The smoothing factor should be set to 4. 

③ Starts the calculation of the seabed layer. 

How to remove spikes from layers 

During the digitization of the seabed or any other layers spikes or outliers can occur. 

Those unwanted parts of the layer can be removed very comfortable by The Remove 

Overlaps within Layer tool. 
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① Shows the layer with spikes. 

② For removing the spikes the part where the spikes are located needs 

to be digitalized again. That can be done by the capture mode or 

rather freehand. This is displayed in the picture as red line on top of 

the black seabed line. 

③ Once this part is digitized correctly the remove overlay tool can be 

opened under Edit → Remove Overlaps within Layer… or rather by 

pressing on the following icon  from the tool bar. 

④ Begins to replace the parts of the previous layer by the new drawn 

parts. The result is shown in the following picture. 

How to replace on-line water depth with digitized seabed layer 

Once the seabed layer was digitized and was adjusted of spikes it is needed to save 

the work in order to avoid re-editing. The most elegant way is to write back the 

cleaned seabed layer into the data file. This procedure will replace the on-line 

calculated seabed. The function can be found either under Extra → Write Water 

Depth to Active Data File… or can be selected from the icon  (when hovering 

above any icon the description is visible), with tag Write Water Depth to Active Data 

File…. 
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① ***Option*** This option can be considered if the seabed layer from 

the current channel (HF) should be also used to replace the on-line 

depth values of low frequency (LF). This results in the same seabed 

layer for the HF and LF channel. 

② Starts the replacing of the on-line depth values for the selected 

channels. 

The layer can be restored by the Insert Water Depth as Layer tool. The dialog can be 

found either under Extra → Insert Water Depth as Layer…  or can be selected from 

the icon (when hovering above any icon the description is visible), with tag 

Calculate Depth. 

① Instead of re-calculation the seabed layer, the seabed can be restored 

from the file.  

How to digitize a sediment layer 

A typical application for a sub-bottom profiler is to find sediment layers and determine 

the thickness of the material.  

Before digitizing sub-bottom layer a few notices should be considered.  

• The sub-bottom layers are typically taken from the LF channel. The 

loading of the different data channels is described in the section The 

loading of data Files. 

• Generate or load the seabed layer as described above. It is 

recommended to reserve “Layer1” as seabed layer. 
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• It is furthermore recommended to 

select different layer numbers for digitizing 

units of different material properties.      

① Select the next free layer number from 

the pull down menu. (“UNIT1”)  Renaming 

of layers and setting up different properties 

such as pen width and color is described 

under How to change layer names and set 

pen properties for each layer. The shown 

layer name on the top of the pull down 

menu (“UNIT1”) is the active layer. All 

function concerning layers such as drawing, copy, paste, smoothing and many more 

to be applied to this active layer. 

• There are two different ways to generate a sub-bottom layer in the plot: 

1. Free Hand: Press the left mouse button and move the cursor 

onto the echo plot. The line segment is drawn until stop moving 

the mouse and releases the mouse button. This procedure can 

be repeated to draw more line segments. From The Pen Dialog

different drawing modes can be selected such as free hand, lines 

and polygons. This method can be used if the data quality is 

poor. The accuracy of this procedure is consequently low and 

can consume a lot of time if the drawing has to be accurate.  

2. The Capture Mode is preferred for digitizing sub-bottom layers 

and is described below. 

The Capture Mode dialog can be found either under Edit → Capture Mode… or can 

be selected from the icon     (when hovering above any icon the description is visible), 

with tag Capture Mode. In order to stop the Capture Mode the same button can be 

pressed again.  

① Set a suitable search band around the cursor cross. For faster 

drawing a bigger search band is helpful because it is easier to follow 

the layer roughly. If there many adjacent layer or noise a smaller band 

width should be used. 
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② Set the amplitude level to 50% as a kind of start value. This value 

controls the sensitive of the capture algorithm. Lower values are more 

sensitive than higher values, but the algorithm tends to fit then to 

noise peaks in the surrounding area of the cursor position if the 

amplitude level of the layer is not very different from the amplitude 

level of the noise. To find the best settings for the band width and the 

sensitivity it might be necessary to make some experiments with the 

parameters. 

③ ***OPTION*** The Auto Search Mode calculates and displays a layer 

for a certain length beginning at the cursor position and looking ahead 

to the right hand side with the defined length.    

④ By pressing the Activate button the cursor cross is extended with two 

lines. Both lines represent the search band width. The drawing of a 

layer segment works in the same way as during the free hand drawing 

mode. The line will fit automatically to a sediment layer during the 

mouse movement if the algorithm can find one. 

In most cases it will be necessary to smooth the layer. This can be 

done by Smooth Layer tool. The tool can be found under Edit → 

Smooth Layer…

How to Save and Reload Layer  

Once the layer is edited, the information should be saved. The Save Layer as…

dialog can be found either under File → Save Layer as… or can be selected from the 

icon     (when hovering above any icon the description is visible), with tag Save Layer 

File. 

① Select the Save Layer as… either from the file menu or from the tool 

bar. 

② Choose the desired file location and choose a suitable name. It is 

recommended to use the automatic given file name.  

③ The save button will finalize the saving. 
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Before reloading a layer, the data file must be loaded with the same parameters for 

stacking (horizontal and vertical) and mirroring. If the data file is loaded with other 

values for those parameters the saved layer file won’t fit to the data. The layer can be 

corrected by scaling and mirror functions. These can be found within the tool bar  

or under Edit → Mirror Layer… and Edit → Scale Layer…. In order to avoid 

struggling with those functions, it is recommended to use the same loading 

parameters which were used during the layer interpretation and apply a different 

stacking factor afterwards whereby the layer will be scaled automatically. Select the 

Open Layer File… either from the file menu or from the tool bar.    

① Browse to the file location. 

② Select the according layer file. 

③ Press the load button to load the layer file. 

How to Export Layer 

Once all layers were interpreted they can be exported to an ASCII text file. Those text 

files can be imported into third party software for e.g. creating a map or for further 
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calculations. The Export Layer dialog can be found either under File → Export Layer 

Data… or can be selected by shortcut Crtl+E. 

① Browse to the desired folder for saving the ASCII files. Select suitable 

file name or use the given file name.  

② If there is only one layer e.g. seabed the file option All to One File is 

fine. If there are more than one layer it should be considered to create 

separated files for each layer. The file option therefore is Separated 

Files for Layer Selection. 

③ The setting here depends on how many layers have been interpreted 

within the echo data and which needs to be exported. If unsure set to 

All Layer. All Layer is just working in combination with the file option 

Separated Files for Layer Selection. 

④ Start exporting the layer. 

How to Export Echo Data as Graphics 

In order to use the echo-prints in presentations or to handed over to other people it is 

useful to export the data into graphic files such as *.gif, *.bmp or *.tif. The graphic 

export can be found under File → Export Graphic…
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① In order to get an output with annotation and some profile information, 

Write Graphic File with header and annotation should be ticked on.

② Press Okay and select a folder and a file format for the output file.  

Due to the compressing algorithmus the jpeg format is not 

recommended for exporting the echo data. 

How to use the Process Script tool 

The following chapter describes the use of the Process Script tool based on an 

example of loading data and calculating the seabed layer. The script tool can be found 

under Tools → Process Script…

① Select the command from the pull down list.  

② Insert all files to be processed. It is important that no empty rows are 

in between.  

③ Execute the script. 

④ *** Optional**** The script can be saved for later use. Just select a 

location and set a file name. After saving the script continues. 

⑤ The script continues without saving the script.  
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⑥ Set up the preferred settings to load the data files and confirm with 

Okay. All files are loaded with same settings. 

⑦ Set up the preferred settings for water depth calculation or use water 

depths from file. 

⑧ Confirm with Yes to start the script. All data files will processed with 

the same settings were made in the previous dialogs. 
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How to generate a list of embedded point features 

This chapter describes the digitization of single reflectors such as hyperbolas from 

pipe crossing or boulders and creating a list of all digitized objects. The tool which 

helps picking the objects is called Target Picker and can be found within the Tool 

Box Dialog. In most cases the digitization of single reflectors has to be accurate. 

Therefore small stacking rates and interpolated coordinates are recommended. Load 

one or more data files with the preferred settings and the seabed layer. Select an 

unused layer and open the Target Picker tool box. 

① Klick the Pick Target button and klick on the target within the echo 

data. The fields Pos. X:, Pos.Y: and Z-Value: should be filled with 

data of the cursor position. 

The object sign and tag can be treated as overlaid text. Those 

can be modified by the Text Block editor.  

Object sometimes very hard to identify, consider using the Zoom 

Box to zoom the area around the cursor position.  

② Click the Select Seabed button and klick with the mouse pointer on 

the seabed above the target. That will calculate the coverage on top 

of the target. This is also working for object within the water column.  
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③ Click the Select Left and Select Right Border button and select the 

outer limits of the object if visible. This will calculate the horizontal 

expansion of the target along the track based on coordinates. 

④ Enter an ID or use the automatic function to increase the ID’s. There 

is also a place holder for a comment and a quality indicator.  

⑤ Enable the option to create a picture of the picked object and the 

defined area around the object. The filename consist of the data file 

name and the object number. The picture file can be found within 

same folder as the data files.   

⑥ Once all needed information’s were taken, press Append to fill the list 

with the data. It is possible to use the same data file to pick further 

objects or open or rather switch to the next echo data to pick more 

objects.  

Before the data file is going to be closed, use the Save Layer 

As… function to save the digitized object including tag to a layer 

file. 

⑦ In order to avoid loss of the data due to computer or software crash, 

the list should be saved as a standard ASCII file from time to time. 

The buttons can be used to save, to load or to clear the items from the 

list.  

How to generate equidistant echo plots 

Echo plots which are recorded by the SES-2000 echo sounder are ping or time, not 

distance orientated. That means each ping is stored independent of the vessel speed 

or actual ping rate. Therefore, an echo plot can show the same distance in reality with 

different lengths on the plot. The ISE software provides a tool to generate time and 

speed independent echo plots so called Track Accumulation. The track 
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accumulation is doing a ping stacking but instead of numbers of pings the distance is 

used to accumulate the data by an average algorithm.  

Before equidistant echo plots can be created a few notices should be 

considered.  

1.  Before applying the track accumulation the coordinates have to be 

interpolated. 

2.  It is recommended to use metric coordinates.  

During the data open dialog the track accumulation can be enabled. 

① Enable the track accumulation and set a distance. All pings within the 

selected distance will be used for stacking. This will result in a 

constantly scaled plot in horizontal direction. The track accumulation 

can be combined together with the standard ping accumulation 

(stacking).  

How to overlay a sediment probe to an echo plot 

In order to overlay sediment probes to the echo data, the samples have to be created 

with the sediment probes editor. The editor can be found under Probes → Sediment 

Probes…. 

① Add a probe to the list view and mark the probe to be edited.  

② Fill in the needed information into the text fields. It is recommended to 

use the online water depth (if spikes were removed already) to locate 

the probe in vertical direction. 
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③ Add a thickness of a layer within the upcoming window. Furthermore 

set a color and use the given pattern for a better differentiation of the 

units. Repeat this for each sample/layer/unit within the probe.  

④ Use for deleting or editing the marked sediment layer. 

⑤ Save the sediment probes in a file for later use. 

⑥ Close the sediment probes editor and select Probes → Overlay 

Echo Plot with Sediment Probes…. 

⑦ Enable Draw Sediment Probes in order to overlay the probes data 

base. Set a maximum distance to the profile to exclude samples 

which are too far away. 

⑧ Visualize the probes either as vertical lines only or as complete 

sediment probes. 

⑨ Enable the desired tick boxes to add labels to the probes. 

⑩ Confirm with Okay to overlay the probes to the echo plots.  
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How to apply different speed of sounds to the water column and to 
the sediment body 

During the online data acquisition it is possible to enter an average of the speed of 

sound only. This speed of sound is used to process the vertical way units for the 

entire profile. In order to improve the accuracy of the distances of the vertical way 

units, it is possible to apply a speed of sound profile for the water column and to 

adjust separately the value for the speed of sound of the sediment body. The speed of 

sound editor can be found under Probes → Sound Velocity Profile.   

The correction of the water column works until the sediment body begins. 

Therefore it is necessary to load a valid seabed layer.  

① Enter the values for the speed of sound according to the depths. 

② Save the entered profile for future use. 

③ Press Activate to apply and select Probes → Correct Echo Plot 

with Sound Velocity Profile…
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④ Select the layer number which contains the seabed layer.  

⑤ Enable the SVP correction. Optional enable Change Water Depth 

Layer to correct the seabed layer also.  

⑥ Enable to correct sediment body with chosen sound velocity. If the 

interpretation of layers is already done, enable Change Sediment 

Layers to move the layers as well. 

⑦ Press Okay to apply SVP correction to the echo plot. 
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Without SVP correction With SVP correction for water column and 

sub bottom 

How to work with the GIS module 

The GIS module is primary used for georeferenced interactions and should be used 

for loading data files. For the functionality overview the section The GIS Tool Box

should be read. The dialog can be opened by clicking the button of The Main Tool 

Bar or by checking the GIS Map View under Options → Toolboxes. 

① Open The Gis Map View Loading Dialog to load the files which shall 

be used. It is possible to open SES-2000 files in both formats, the 

*.ses (envelope data) and the *.raw (full waveform signals). 

The starting point of each track line (first coordinate) is indicated 

in the GIS Map View by a bold black marker. 

Latitude/Longitude coordinates must be in decimal degrees, any 

formats with degrees, minutes and seconds or decimal minutes 

are not supported. 

② Open one or multiple background images. 

It is possible to open background data in various formats, such as 

GeoTiff, IHO S-57, MapInfo, AutoCad DXF, DWG or ArcView 

SHP. In most cases the coordinate system of the background 

data will be recognized automatically and proposed to the user. 

Some file formats, such as BMP, may not contain coordinate 

information and will use counted pixels as coordinates instead. 

Once a background map is opened, the full extent of the map 

window will be adjusted and the grid lines and grid points will be 

calculated accordingly. The display order is the same as the order 

they were opened. 

The transparency for each background layer can be changed 

individually via a right mouse button popup menu. 
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The Scale bar and North Arrow are with a valid coordinate system only. 

When loading SES-2000 tracks or background files you should define a valid 

coordinate system, either by its name or by its EPSG code. 

③ The related SES-2000 data file can be opened in an ISE interpretation 

window either by choosing Open Echo Plot from the right mouse 

button popup window menu or by clicking the button Open selected 

Track on the button bar. 

The visible part in the interpretation window is additionally 

highlighted in the main window of the GIS Map View and the 

cursor position in the interpretation window is indicated by a bold 

cross in the map view. The highlighted visible echo plot region 

and the cursor position are updated automatically during user 

changes and scrolling in the interpretation window. 
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The figure shows the GIS Map Window with some SES-2000 track lines and a 

background map in GeoTiff format. The selected coordinate system is WGS-84 UTM 

zone 30N, which is internally represented with its EPSG code 32630. The highlighted 

area in the overview window represents the visible part of the entire map data in the 

main window. Accordingly, the two bold cross lines refer to the centre point of the 

main window. Grid lines and Grid points have been added to the scene automatically 

and will change with different zoom levels. The cursor mode is set to the “Select 

Mode” per default. You can either choose a filename from the map layer window or 

click directly into the main window in order to select a single track. The selected track 

becomes highlighted. 

It is possible to load sediment probes and numerical probes. The data have to be 

loaded as described under How to overlay a sediment probe to an echo plot. Each 

sediment probe or numerical probe will be represented by a symbol and with its ID in 
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the main window. The coordinate of the probe is the tip point of the lower triangle. Any 

changes in the probe data base will update the map view as well. 

Gis Tools 

Bathymetry 

④ The SES-2000 track data contains water depth information which can 

be shown in the GIS Map View by clicking the button Show Depth 

Colours. 

The depth source can be either the HF channel (high frequency) or LF 

channel (low frequency), if available. 
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Side Scan Coverage 

⑤ If the SES-2000 track data consist of side scan files it is possible to 

show the coverage in the GIS Map View by clicking Show Side Scan 

Coverage. 

The covered areas on the port side are colored in red; the covered 

areas on the starboard side are colored in green. The GIS Map View 

uses transparency in order to make overlapping parts recognizable by 

increased color strength or a mix of red and green colors. 

Cross Point Calculation 

⑥ The GIS module provides the functionality to calculate cross points for 

all track lines within the GIS Map View by clicking the button Calculate 

Track Cross Points. 

All calculated cross points appear in the Map Layer window under the 

target list and are labelled automatically by counted numbers. In the 

GIS Map View all targets are shown as circles with a centered cross, 

indicating the target position. 

A file dialog will ask for a file name to store the cross points as a text 

file. The text file contains the cross point coordinate, a place holder for 

z-values (set to ‘1’ and not used in the GIS module), the target ID and 

the two names of the track lines which relate to the cross point. This 

text file can be imported in the ISE software directly under Probes → 

Overlay Echo Plot with Sediment Probes… in order to show all 

cross points as vertical line markers in opened interpretation windows. 



164     ISE 2.9 User’s Guide 

Innomar Technologie GmbH, October 2017 

Export Voxler Data 

⑦ The Voxler Area Export helps to export raster orientated point cloud 

data. The button will open a little dialog window, where the upper left 

corner has to be selected by entering a coordinate manually or either 

by using the mouse pointer in combination with the pick button. It is 

also needed to enter a size for the tiles and entering the number of 

tiles in X and Y direction in order to cover the entire area. The 

geometry can be check by clicking on the “Update Gis Map” button. If 

everything is okay a script can be selected from the pull down list and 

can be started by clicking the “Generate Voxler Files” button. Only 

visible data files will be used for the export.    
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How to export Fledermaus curtains 

It is explained how to export IVS Fledermaus SD files from the ISE software to be 

visualized as SBP curtains or fence diagrams in the Fledermaus software or the free 

available IVS iView3D/iView4D tools. Therefore select File → Export Fledermaus 

Curtain. 

The ISE software allows the export of individual SD files for each SES-2000 profile, 

but allows the combination of several SES profiles within a single SD file as well. Such 

combined file gives an immediate display of a so called fence diagram. 
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During the export the user has the choice between files written as shown in ISE (i.e. 

with no transparency), but also with a transparent water column, a transparent 

background color or a combined transparency. 

For the visualization it can be useful to remove the horizontal ruler lines and/or all 

vertical marker (i.e. track marker, event marker) because the IVS Fledermaus 

software provides labels and axes with coordinates and depth information. Before 

exporting SD files it is necessary to interpolate the coordinates within the SES-2000 

data files because it is required that each ping has its own coordinate. This will result 

in an accurate track and accurate projection of the echo plot onto the usually not 

linear but curved curtain. Any differences in speed and lateral scale of the echo plot 

will be automatically removed by the projection into real world coordinates. 

Visualisation of SD files in IVS Fledermaus and the free IVS iView software  

The free IVS iView3D/iView4D tools allow the import and display of single SD files, 

but do not show several files at once. In order to combine several SES-2000 profiles 

the ISE export function to extend previously created SD files can be used. In order to 

combine SES-2000 curtains with MBES surfaces and/or side scan imagery you need 

the have a license of the IVS Fledermaus package. 

The Fledermaus software with a view of several composed SES-2000 profiles can be 

combined with an additional Multi-Beam Echo-Sounder (MBES) surface. 
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How to convert SES3 files 

This guidance explains how SES3 files are converted into RAW files for SES-2000 

quattro systems. To do the conversion open Tools → Convert SES3 Files…. 

① Selection of the desired files which shall be exported 

A selection of files with different corrections applied to apply 

again the offset correction is not recommended. 

• General Settings 

② Use the recommended coordinate interpolation to ensure gaining 

correct positions for the generated RAW formatted track files. The 

heading information is needed for the interpolation to correct the 

coordinates in a correct manner with the Navigation Offsets and 

Coordinates Interpolation.  

③ Set the correct spacing for the transducer configuration. 

④ Select the correct transducer type. 
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• Navigation Offsets 

In this example one file is used with online applied navigation offset which is 

referred by the Remaks entry NO (at ①). Therefore the antenna offsets of 

Navigation Offsets will be leave as zero. 

• Motion sensor 

In this example the lever arm correction has to be done. As it’s seen at ①, the 

three other, not selected files have the additional entry LA at Remarks. This tells 

that the lever arm correction and the navigation offset are already done online.  

⑤ The information tells that the selected file needs a lever arm 

correction. 

⑥ Enter the offset from the center of gravity to the motion sensor. 

⑦ Enter the offset from the center of gravity to the SBP transducer. 

• Motion sensor special options 

In this example we do not need any special options. 

• Conversion 

⑧ Information give an overview to the done settings in order to check if 

everything is correct selected. 

⑨ Execute the conversion. 

⑩ Finish the conversion. 
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How to generate voxel files out of SES files 

This guidance explains how the voxel can be generated out of the SES files, to be 

able to view the recorded data in 3D. 

If SES3 files shall be processed these files have to be converted into RAW 

files before the processing could be started. The conversion processing is 

explained under How to convert SES3 files. 

The processing itself consists of following two main parts: 

① Export of the recorded data as x, y, z, s file 

Before the recorded data is to be exported, it has to be 

processed as usual (i.e. coordinate interpolation or filtering). 

② Loading and processing the exported data into the SESGridder. After 

processing the data with the tool it will generate the voxel grid file. 

The SESGridder allows during the processing a view into the 

generated voxel grid. 

Export recorded data in required format 

The following steps have to be considered to export the data after all desired files are 

processed. Select Tools → Process Script…. There exists a raster orientated export 

inside the GIS module which is called Voxler Area Export, too.  

① Select a command to export the voxel format: 

LOAD_DATA_FILE_+VOXLER_CLOSE 

- will load all selected files, export the data with corresponding 

coordinates of every selected file into a separate file and close all 

selected files. 

LOAD_DATA_FILE_+Waterdepth+VOXLER_CLOSE 

- will load all selected files, determine the water depth, export the 

data with corresponding coordinates of every selected file into a 

separate file and close all selected files. 

② Load all files which shall be exported by clicking Insert and then by 

browsing and selecting the desired files. 

③ By pressing the Start button the Load Data Dialog will open once for 

the selected files. 
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④ Make settings within The Voxler Output Settings Dialog and 

execute the exportation scripting by pressing Ok. 

Under the assumption of the usage of the SESGridder for the 

voxel grid generation remember the entered scaling because this 

is important for the vertical voxel spacing. Further it is 

recommended not to use the stacking. Because this will generate 

data gaps in vertical direction which probably cause unwanted 

empty planes. 

Generate the voxel grid with the exported data 

The following explained processing steps, which is marked with red digits, has to be 

passed to generate the voxel file. Optional steps are marked with orange digits. 

Bordeaux colored digits or characters are outside of the processing steps. 

Not all possible settings are described here. The SESGridder interaction 

possibilities are almost self-explanatory. 

Described version of the SESGridder is 1.0.1.6 from December 2016. 

• First usage 

During the first execution of the SESGridder the user have to decide which of the 

available devices shall be used for OpenCL calculations. This can be changed 

under the tab Options. 

① Select a platform to which several OpenCL capable devices may be 

assigned to. 

② Select an OpenCL capable device which shall be used. 

③ Test whether the selected OpenCL capable device fulfills the 

SESGridder software specifications. 

④ Use the elected device or let the SESGridder choose a device. 
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• Input 

① Load special formatted files are structured as following: x y z s 

The x, y and z represent a coordinate with a corresponding signal 

value s. 

Select all files from the folder which shall be used for the voxel grid 

generation. All files have to be of type .txt for text files or .bin for 

binary files. 

The x, y and z are floating point values. The s is an integer value. 

They have to be separated by single spaces and every entry has 

to be in a separate line. By contrast to this text files the binary 

files are without any separator or new line. For the binary 

formatted files x and y have to be double precision floating point 

(64-bit) values, z has to be floating point (32-bit) and s has to be 

of signed short type (16-bit). 

② For experienced user it is possible to adjust the voxel grid during the 

usage of Grid Inspector, which is a processing part of the 

SESGridder. Possible existing correction files, which may be saved 

during this special adjustment, can be loaded again as well. 
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• Settings 

③ If some suitable setting for the selected data files is chosen, then all 

settings done and saved to a previous date will be loaded. 

As mentioned entered settings can be saved for re-use. Open the 

managing dialog by clicking Manage Gridder Settings. 

Further it is possible to take a snapshot of this tab with Snapshot 

Gridder Settings. 

Best moment to save settings is during voxel grid generation is 

running, because this will usually need some time, primary 

dependent on the data amount. Or save the settings before 

saving the generated voxel grid. This will ensure saving the last 

state which may has changed during the usage of the Grid 

Inspector. 
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④ The most important setting for the voxel grid generation step, is 

entering the boundary limits of the voxel volume. 

The boundaries defined by all selected files can be determined by 

clicking Execute Boundaries Calculation. 

The coordinate boundaries have the same unit as your input data. 

Further the voxel dimension has to be entered. Optionally the spacing 

of a voxel can be entered which refers to the unit of the input as well. 

The entered spacing will automatically provide a voxel size. 

⑤ The calculation settings are essential for the grid generation as well 

as for any recalculation. 

They can be changed after the grid generation step has finished. 

Enter search radii for the x and y axes. If a generated voxel does not 

contain any coordinate, a value may be interpolated according to this 

radii and the weighting factor. 

Single empty planes, which may occur through a too low spacing in z 

direction, can be interpolated as well. 

The gap filling feature fills empty voxels with values dependent to the 

adjacent voxels. The number of voxels of a gap which will be 

interpolated has to be defined as well as the interpolation direction 

(horizontal or vertical or both). 

Careful with stacking in z direction during data exportation. This 

may lead to not compensable multiple empty planes. 

For experienced user: To do a fast first calculation to get a more 

or less fast preview in the Grid Inspector let the search radii 

being zero. As mentioned before these values can be 

manipulated again later. 

As advice the search radii should be a factor between 1 and 2 of 

the corresponding spacing. 

Note that for the data example of the screenshots the full range without zero 

offsets and a scaling of -0.1 was used for the data extraction. With a scaling of one 

the proposed boundary limits would be from 100 to 590. 
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• Gridding 

The grid has to be generated before further interactions are available. 

⑥ Execute the grid generation and wait until all substeps have finished. 

⑦ Enter a filename for the output or browse and select an existing text 

file. 

Decide whether a separate text file shall be written including the done 

settings. 

The generated voxel grid can be kept into RAM after the grid is saved. 

This allows more or less quickly generating another voxel grid file with 

changed calculation settings or another vertical track offset which can 

be changed within the Grid Inspector. 

Choose the exportation data type (signed short 16-bit or floating point 

32-bit with or without normalization between -1.0 and 1.0) 

If no file name is entered before the Save Grid button is pressed, 

the output filename will have the same name as the first entry of 

the selected file list, except the extension. 



178     ISE 2.9 User’s Guide 

Innomar Technologie GmbH, October 2017 

⑧ Save the generated voxel grid. If for the voxel grid a relevant change 

has occurred, then the user will be asked for recalculation before 

saving. 

⑨ Open the Grid Inspector to view into the generated voxel grid and for 

applying vertical track offset changes. 

⑩ Discard generated voxel grid without saving which allows to change 

the essential settings or to change file selection. 

• Grid Inspector 

The inspector allows not only to get a view into the generated voxel grid but to 

change the vertical track offset for single files. Accordingly loading single files 

representing only one recorded track allows more flexibility in changing than a 

combined data file. 
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The view options for the Grid Inspection offer a lot of opportunities. 

A The vertical track offset correction is done by clicking on the increase 

or decrease signs at the right of the list view. The current selected file 

will be shown as a red line strip if the selected view is top or bottom. 

The ticked files are shown as well in this both views with the selected 

color of Track color. 

Further is for each file shown which vertical track offset correction is 

currently applied to its data in the voxel grid. 

B The current applied vertical track offsets to all files will be saved to the 

entered output filename by pressing Save Offsets. 

C If the available setting for automatic recalculation, which can be found 

under Options, is ticked then all done vertical track offset changes 

are recalculated and applied to the voxel grid automatically. Otherwise 

this is done manually by clicking Recalculate. 

D View: Top, Bottom, Front, Back, Left, Right

- The View means the direction looking at the voxel grid. 

Assumptions are that the Bottom has a lower value than the Top

and that Front as well as Left have lower values than Back

respectively Right. 

Plane: 1..n 

- The plane means the current shown voxel grid plane dependent on 

the selected View. 

E Amplitude colors mean the color spectrum which is used to draw the 

voxel of the voxel grid with the chosen range of amplitude values. The 

range is defined by the entered minimum and maximum amplitude. 

F The Track color specifies the drawing color for the ticked files. 

G If Show grid is ticked the voxel grid its voxel borders are drawn with 

the selected color. 

H If Show positive oriented axes is ticked the coordinate system axes 

determined by the current selected View are shown. 
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There are several interaction possibilities for the viewing window. Most important 

are moving by pressed left mouse button, zooming by scrolling the mouse wheel, 

position and zoom reset by clicking middle mouse button (mouse wheel button) 

and plane switching by key up or down pressing. 

• Options 

The options provide different information. The device selection for the OpenCL 

usage can be changed, which is only needed for the Grid Inspector. Further 

possible and changeable options are the color scheme and the option for the 

automatic or manually recalculation when a vertical track offset adjustment will be 

done, which is relevant only for the Grid Inspector. 

Usage of the generated voxel file 

This example explains how to load the generated binary data file by the SESGridder

into third party software which is in this case the Voxler®. 

In this case the settings were saved into a separate text file, from which it is easy to 

get the necessary loading input for the Voxler®. 

It is only described how to load the data into the Voxler® but not how to go further to 

get the view. For example the volume renderer has to be added to visualize the 

volume. 
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① Execute right click to open popup menu and click on Import. If it is 

done the setting dialog for the file loading occurs after selecting the 

generated binary file. 

② Leave the signed short type. 

③ Enter the voxel dimensions. 

④ Leave the little endian format. 

⑤ Leave the index order x, y and z. 

⑥ Enter spacings and optionally the origin (minimum coordinates) to get 

a correct axes labeling. 
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Appendix A - 

File Formats 

During the work with the ISE software different file formats are used. The SES-2000 

data format will be processed automatically and is not described here, but some other 

formats, e.g. the tide data file format, are important for the user of the software. 

The SES-2000 Data File Format 

The SES-2000 data format is a binary format which contains the digitized echo signals, 

the information from navigation systems, the data from motion sensors and different 

system parameter settings. The file size is set to 128 Mbyte by default within the online 

acquisition software. The maximum file size can be modified.  

Do not edit SES-2000 data files manually. This can cause errors during further 

processing and operation with the files. 

The Tide Data File Format 

Tide data files can be imported by the ISE software. These files have to be ASCII files 

with the following structure: 

Column Description 

1 The date as a string in the form 01.01.2015 

2 The time as a string in the form 12:05 

3 The tide level as a number in cm like 315.0 

Every minute must be defined in the file. If no tide data are available for specific times 

of the day, the tide level value can be set to zero. The columns have to be separated 

by space characters. Common file extensions are “asc” and “tid”. 

The Layer Data File Format 

This is also a binary format. The file size depends on the size of the layer information 

included in the file. Layer files can also be loaded into data windows with different data 

files than the ones they were created from. Layer files contain information about the 

digitized features, the colors and the manually added annotation. 

Do not edit layer data files manually. This can cause errors during further 

processing and operation with the files. 

The standard file extension is “sch”. 
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The Layer Definition File Format 

This binary format contains all preferences from the layer editing. It is useful to save 

the selected pen colors and pen widths into a file. So these preferences can be 

reloaded to other files for easy editing set up. The standard file extension is "sdd". 

The SIS File Format 

This file format will be used within the SIS Replace function. If the SIS data strings 

were exported and recalculated with external software, they can be inserted into the 

data files again. The number and sorting order of the columns are variable but the 

maximum number of columns is limited to 8. The SIS files are text files with the 

following typical structure: 

Column Description 

1 The time as a string in the form 10:05:20 

2 The X position as a floating point number 

3 The Y position as a floating point number 

4 The Z value as a floating point number 

The Sound Velocity Profile File Format 

This ASCII file format contains a list with all speed of sound values and the regarding 

depth. The depth can be positive or negative, depending on the given option during the 

saving operation. Both formats will be loaded by the ISE software. The standard file 

extension is "svp". 

Column Description 

1 The depth in meters as a integer number 

2 The speed of sound in meter per second as a floating 

point number 

The Numerical Profile File Format 

This is a binary format. The file size depends on the number and size of the included 

density profiles. The standard file extension is “den”. Each numerical profile data base 

consists of one or more numerical profiles. To add a single profile, the user has to 

import ASCII files with the following structure: 

Row Description 

1 The unique profile ID as an integer number 

2 The X and Y coordinate values separated by a space 

character 

3 The number N of the following numerical values 
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4 to (3+N) The list of numerical values, where each row contains 

a depth and a floating point number, separated by a 

space character 

(N stands for the value of row 3) 

Do not edit density profile files manually. This can cause errors during further 

processing and operation with the files. 

The Sediment Probe File Format 

This is a binary format. The file size depends on the size of the probe and layer 

information included in the file. The standard file extension is “sed”. 

Do not edit sediment probe files manually. This can cause errors during further 

processing and operation with the files. 

The Sediment Probe Import File Format 

This is an ASCII format. The ASCII based file structure allows the import of several 

sediment probes without manual editing in the Sediment Probe Dialog. Dialog The file 

size depends on the number of probes to be imported. The standard file extension is 

“txt”. A single row contains all information about one sediment probe. The ASCII file 

has the following structure: 

Column Description 

1 The unique probe ID as an 5 character ASCII string 

2 The X coordinate value 

3 The Y coordinate value 

4 An optional ASCII text field for a short probe 

description (no spaces allowed). 

5 An optional Date field for the probe collection date with 

the format DD.MM.YYYY 

6 An optional Time field for the probe collection date with 

the format hh.mm 

7 The ground level of the probe given in meters. The 

value has to be negative for a typical depth below a 

water level of 0.00 m. 

8 The number N of the following sediment layers 

9 to (8+N) The list of numerical values, where each column 

contains the thickness of a sediment layer, given in 

meters. 
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The import file format does not contain information about the sediment type and 

color for the graphical overlay of the probe. These data need to be edited 

manually after importing the probe information. 

The Target File Format 

This is an ASCII format. The ASCII based file structure allows the import of several 

targets. The standard file extension is “txt”. A single row contains all information about 

one target. All columns are separated by a space or by a tab. The ASCII file has the 

following structure: 

Column Description 

1 The X coordinate value 

2 The Y coordinate value 

3 The Z coordinate value 

4 An ASCII text field for a ID of the target 

5 An ASCII text field for a short information or description 

of the target.  

The Bitmap File Format 

This is a standard binary Windows® Bitmap format. It is palette orientated and contains 

256 different colors. In the exported bitmaps the echo plot from the screen as well as 

the header and the coordinates are included. It is the same appearance as in the 

printed echo plots. The standard file extension is “bmp”. 

Instead of using Bitmap files it can be more efficient to export the graphic into 

GIF files. These GIF files are created with a compression algorithm without any 

loss of quality, based on 256 colors and high compression rates. 

The GIF File Format 

This is a standard binary GIF format. It is palette orientated and contains 256 different 

colors. In the exported graphic the echo plot from the screen as well as the header and 

the coordinates are included. It is the same appearance as in the printed echo plots. 

The standard file extension is “gif”. 

The GIF file format is the recommended format to be used for graphics export. It 

has the best compression rate without a loss of data and detail. Bitmap files are 

very big and JPEG files create artefacts within the echo plot due to the 

compression algorithm. 
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The JPEG File Format 

This is a standard binary Windows® JPEG format. It is true color orientated and uses 

data compression techniques to save space on a storage medium. In the exported 

JPEG files the echo plot from the screen as well as the header and the coordinates are 

included. It is the nearly the same appearance as in the printed echo plots, only due to 

the data compression some pixel artefacts may appear. The standard file extension is 

“jpg”. 

Instead of using a JPEG file it can be more efficient to export the graphic files 

into GIF files. These GIF files are created with a compression algorithm without 

any loss of quality, based on 256 colors and high compression rates. 

The SVG File Format 

This is an ASCII file format following the XML specification to describe scalable vector 

graphics. SVG files can be created during the export of layer data. One or more edited 

and visible layers are exported with relative coordinates to the upper left corner. 

Additionally a link to the background echo plot may be part of the SVG file if selected 

during the export. SVG files can be opened and edited by several graphic programs. 

The standard file extension is “svg”. 

The CODA File Format (Custom Format) 

This is a user specific ASCII file format following the scheme of the CODA processing 

suite. CODA files can be created during the export of layer data. One or more layers 

can be written into a single output file. The layers are divided into segments with Start 

(S), Intermittent (I) and Stop (E) indicators. Position information and other data, e.g. 

Time and KP values are exported too, if available. The following table shows the 

column structure and one small segment as an example. Each row in the CODA file 

represents a single coordinate and one segment must have at least two rows (with S 

and E indicator). Some columns are not used and set to zero. Delimiter is per default a 

Tabulator character. 

Date Time Layer KP X value Y value Z 

value 

No 

Use 

ID 

15.06.2015 081218.0 Layer2 0.010 4526.66 0415.42 36.46 0.0000 S 

15.06.2015 081219.0 Layer2 0.012 4526.65 0415.35 36.47 0.0000 I 

15.06.2015 081220.0 Layer2 0.015 4526.65 0415.29 36.48 0.0000 I 

15.06.2015 081221.0 Layer2 0.017 4526.64 0415.24 36.46 0.0000 E 

The PIPE File Format (Custom Format) 

This is a user specific ASCII file format following the same scheme as for the CODA file 

format. PIPE files can be created during the export of layer data, especially when 
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pipeline reflectors are digitized. The seabed and the top of the pipeline can be written 

into a single output file or separate files may be exported. The layers are divided into 

segments with Start (S), Intermittent (I) and Stop (E) indicators. Position information 

and other data, e.g. Time and KP values are exported too, if available. The following 

table shows the column structure and one small segment as an example. Each row in 

the PIPE file represents a single coordinate and one segment must have at least two 

rows (with S and E indicator). Some columns are not used and set to zero. Delimiter is 

per default a Tabulator character. 

In contrast to the CODA file format the Layer description is fixed to the strings “seabed” 

and “topofpipe”. 

Date Time Layer KP X value Y value Z 

value 

No 

Use 

ID

15.06.2015 081218.0 topofpipe 0.010 4526.66 0415.42 36.46 0.0000 S 

15.06.2015 081219.0 topofpipe 0.012 4526.65 0415.35 36.47 0.0000 I 

15.06.2015 081220.0 topofpipe 0.015 4526.65 0415.29 36.48 0.0000 I 

15.06.2015 081221.0 topofpipe 0.017 4526.64 0415.24 36.46 0.0000 E 
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The ASCII Convert & Export File Format 

This is an ASCII file format which is used during the ASCII conversion of SES-2000 

data and during the export of signal traces. The table below shows the structure of the 

file. The converter will create files containing several pings, during the export of signal 

traces individually files for each ping will be written. 

The default file extensions are “asc” and “txt”. 

Row Number ASCII Data Description 

1 Time 

2 SIS Field No. 1 

3 SIS Field No. 2 

4 SIS Field No. 3 

5 SIS Field No. 4 

6 SIS Field No. 5 

7 SIS Field No. 6 

8 SIS Field No. 7 

9 SIS Field No. 8 

10 Range Start [m] 

11 Range Length [m] 

12 Frequency [kHz] 

13 Pulse Length [µs] 

14 Sample Frequency [Hz] 

15 Number of following samples [n] 

16 Sample No. 1 

... ... 

16 + (n – 1) Sample No. n 

GIS Module File Formats 

Import Formats 

The GIS Map View can display an overlay of multiple data files. The following classes 

of files are possible to import, not geo-referenced raster data files (i.e. pixel format), 

geo-referenced raster data files (i.e. pixel format), grid files (i.e. point data sets) and 

geo-referenced vector data files (i.e. vector format). 
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Not geo-referenced data files are raster data files, such as Windows Bitmap files, 

where the format does not include any coordinate information. Such files may be 

imported as background data, but the coordinate system will be based on pixels rather 

than real world coordinates. 

Geo-referenced data files are raster data files, such as GEO TIFF, where the format 

includes coordinate information. Such files may be imported as background data with 

real world coordinates. Table 2 shows a selection of the most widely used and 

supported data formats. The list may be extended in future, so please contact Innomar 

for updated information. 

Raster Formats 

*.BMP Windows Bitmap Format 

*.GIF Graphic Interchange Format 

*.IMG ERDA IMAGINE Image File Format 

*.JPG, *.JPEG, *JP2 JPEG and JPEG 2000 File Interchange Format 

*.PNG Portable Network Graphic Format 

*.SID LizardTec MrSid File Format 

*.TIF, *.TIFF Tag Image File Format, GEO TIFF Format 

Grid Formats 

*.ADF, *.ASC, *.FLT ArcInfo Binary, ASCII and Float Grid Format 

*.DEM Digital Elevation Model ASCII Format 

*.DT0, *.DT1, *.DT2 Digital Terrain Elevation Data Format 

*.GRD Golden Software Surfer Grid Format 

Vector Formats 

*.CSV Comma Separated Values point layer Format 

*.DGN MicroStation Native Format 

*.DXF, *.DWG AutoCAD Format 

*.KML Google Earth Keyhole Markup Language Format 

*.OSM Open Street Map Format 

*.SHP ArcView Shape File Format 
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*.XYZ XYZ Lidar Data Format 

*.000 IHO S-57 ENC Format 

Export Formats 

From the GIS Map View it is possible to export either the track data in vector format or 

the entire scene in raster format (Table 3). The export can be started via two buttons in 

the button bar or via the File menu. Track data are always exported geo-referenced. 

The scene is exported as a raster file with coordinates stored in separate World Files. 

TIFF raster files will contain embedded geo-reference information. 

Track Export Formats  

*.DXF AutoCAD Format 

*.KML Google Earth Keyhole Markup Language Format 

Scene Export Formats 

*.BMP Windows Bitmap Format 

*.JPG JPEG File Interchange Format 

*.PNG Portable Network Graphic Format 

*.TIF Tag Image File Format, GEO TIFF Format 



ISE 2.9 User’s Guide     191

Innomar Technologie GmbH, October 2017 

Appendix B - 

Simple Side Scan Processor (Option) 

If a SES-96 or SES-2000 system is equipped with a side scan transducer and the 

relating software, it is possible to record 100 kHz side scan data. The side scan data 

are stored within normal SES-96/SES-2000 data files. The online software allows the 

replay of these data files, but an extended processing might be helpful for a coordinate 

referenced digitization of targets and structures. For this reason a special tool is 

provided, which allows the generation of Bitmap graphics containing a coordinate 

referenced chart of different side scan profiles, slant corrected and processed with 

some signal and picture processing methods. These referenced Bitmaps are usable for 

any chart as a base map for further digitization or plotting with external software 

packages, for example Surfer from Golden Software or Arc View GIS from ESRI or 

others. The software is not real Mosaic software, but it is a handy tool to get some 

mosaic like output of side scan profiles. 

The Side Scan Processor Software 

The Side Scan Processor has no real time display or preview of the generated Bitmap 

graphics, due to the possible big size of the files, which may overflow the graphics 

resources of older Windows® versions. Therefore it is a dialog orientated tool, where to 

define the input data, to process the data and finally to generate and store the output 

data as a Bitmap file. 

The following graphic shows a flow chart of all necessary steps to generate a useful 

output. Already during the recording and before using this tool it is necessary to fulfil 

some requirements. 

 Side Scan data files must contain heading information in one SIS field, coordinates 

in a metric system and the coordinates have to be already interpolated for each 

ping (which can be done within the ISE software). The heading information will be 

interpolated and smoothed temporarily within the Side Scan Processor. 

Use the Side Scan Transducer and record Side Scan Data with Coordinates and 

Heading stored to the SIS fields. 

(Optionally a course may be calculated with ISE, but a true heading is preferred) 

↓

Eventually convert the coordinates into a metric system, if not already recorded and 

calculate the heading from the coordinates, if not already recorded. The ISE software 

provides a SIS Extract and SIS Replace function, as well as a tool to calculate the 

heading from ASCII coordinate files. 
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↓

Interpolate the coordinates, so every ping has its own coordinate. This step is 

necessary, because typically one position per second is available, but there are up to 

30 pings per second generated with the echo sounder system. The ISE software has 

a tool for interpolating the coordinates within the SES data files. 

↓

Optionally a digitization of the bathymetry can be done with ISE and these depth data 

should be stored at one SIS field with the SIS replace tool. This procedure increases 

the quality of the near nadir region during mosaicking. 

↓

Start the Side Scan Processor software and select the data files to be processed 

(multiple files are selectable and a graphical preview is available too). 

↓

Define the input parameters, especially where to read the coordinate and heading 

information from the SES data files. 

↓

Define the output size of the generated Bitmap and scale the input data depending on 

the area to be processed and visualized and depending on the survey speed and the 

achievable ping rate during the survey. 

↓

Define some signal processing parameters to enhance the generated output, like TVG 

and heave correction. Additionally some picture processing parameters, like pixel 

smoothing and the overlay of grids are available. 

↓

Define the output file and destination and start the processing which may take a while, 

if large data sets are processed. 

↓

Use the generated output Bitmap file within third party software for charting, 

digitization of structures and plotting. The Bitmap files are normal MS Windows® 

bitmaps with 256 colors and compatible with all available picture processing and 

visualization and charting software. 
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The Data Source Dialog 

Within this dialog it is possible to select one or more SES data files for the processing. 

Browse to the source directory and select the files by marking them with the mouse. 

Also the port and starboard channel are selectable independently of each other. That 

might be useful in order to avoid too many overlaid Side Scan data within the mosaic. 

At least one file must be selected.  

The Input Parameter Dialog 

Select the SIS string number for the X and Y coordinates within the eight SIS fields of 

the SES data files. Additionally one field must contain the Heading information. It is 

recommended to use the averaging of the heading data to improve the output quality 

of the processing. The heading data normally has too large steps compared to the 

number of pings between each heading value and the resulting smaller change of the 

heading from ping to ping in reality. For the depth data source either the on-line 

calculated depth or a depth value from one of the SIS field may be used. An 

averaging of the depth data may increase the quality of the near nadir region during 

the mosaic calculation. 
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The Scale Dialog 

This dialog is responsible for all settings relating to the output size of the Bitmap and 

the area to be visualized within. The bitmap itself is always quadratic and can have a 

maximum size of 10000 x 10000 pixels (which results in a file size of 100 Mbyte). The 

resulting output file size is calculated and given. Use the Scan Button to get read 

through all selected files and to find the center coordinate within the boundary 

rectangle of the side scan profiles. The center coordinates can be changed and 

defined manually, if specific section from the selected data set is of primarily interest. 

The preview window gives an overview about the vessel’s track. The red area 

displays the backboard side and the green area displays the starboard side and both 

together are representing the coverage of the side scan track. The area of interest can 

be selected directly by clicking the mouse into the preview chart. The buttons shown 

down on the preview window can be used to create a grid according to the size of the 

output bitmap. The arrow buttons are used to move the selected window to the area of 

interest. This is very useful if more the one bitmap is necessary to cover the area. It 

makes sure that bitmaps can be created without any gaps in between.  

Furthermore the Scale factor is given in Pixel per Meter. Depending on the ping rate 

and the survey speed it might be necessary to decrease the number of pixels per 

meter, due to less coverage of the surveyed area with transmitted pings. On the other 

side the visualized area changes by changing the number of Pixel per meter relating 

to the output bitmap size. For this reason the processed boundary and size of the 

area is always recalculated and given on the lower part of the dialog.  
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The Signal Processing Dialog 

Several processing steps are available. If during the survey a motion sensor was 

attached to the SES system, the heave information can be used for a heave 

correction. The averaging of the water depth can decrease errors during the TVG and 

the slant correction, if the bottom was not flat below the transducer or stones were on 

the bottom. A fixed time variable gain can be adjusted in dB/m to correct the received 

signal for energy losses due to geometrical and normal attenuation. There is also a 

possibility to create an own time variable gain curve. The gain curve can be adjusted 

for both sides separately. The amount of amplifying the received signal depends on 

the survey condition and must be found by manual trials. An automatic TVG 

calculation is not available at this time. The slant correction is necessary to get true 

distances of the reflectors from the survey line positions. Slant Range correction 

means the recalculation of the travel time to the true horizontal distance, when the 

height of the transducer over the bottom is known. The area near the center of the 

survey line is not as detailed as with higher distance due to less data points per 

change of distance, but this is normal for this processing method. For this reason side 

scan data plots sometimes are better interpretable without slant range correction, but 

for really coordinate referenced plots it is necessary to do. One signal processing 

method is included to compensate the received signal for changes of the signal 

strength due to directivity and other influences. The amplitude normalization will 

produce an output with a normalized signal level over the whole received signal. Small 

variations due to reflections from objects and structures on the seabed are not 

affected, but if the size of such reflectors is to large or the seabed characteristic 

changes constantly, the normalization may produce wrong amplification levels on 

these areas. A special algorithm is selectable for the signal processing, which is able 

to reduce artefacts around the center line of the profile (nadir region). Finally a 

threshold table can be applied to the processed signal to convert amplitude levels to a 

color or grey scale value for the final picture. This threshold table can have linear or 

logarithmic steps. A logarithmic table will have more steps in the lower amplitude 

range and will therefore improve the visibility of small changes of the signal. The 
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minimum value is used to remove the background noise from the generated picture. A 

higher value for the threshold minimum results in a bigger value for the starting point 

of the threshold table and all amplitudes below will be removed from the picture 

output. The maximum value for the threshold table is given in percent of the total 

dynamic range. A smaller value than 100 percent will decrease the total size of the 

threshold table and will result in more steps for the generated threshold table for the 

given signal amplitude range and therefore in better visible variations of the signal 

amplitude. 

The Picture Processing Dialog 

The picture processing is done after the signal processing. There are several options 

available for the improvement of the output pictures. A selection of different color 

tables and background colors can produce positive or negative pictures (shadows are 

light or dark). Extended pixel sizes are used, to fill blank areas between pings, when 

the ping rate was to low or the survey speed too high for the selected scale factor. 

There are different and combinable options for the pixel extension, which may used 

depending also on the survey direction. For example a North / South profile may be 

filled with vertical pixel extensions only, to keep the originally resolution in East / West 

direction. There is a limit to use the pixel extension, if the blank areas between the 

pings are getting to big. For that reason a function for the interpolation of data 

between the pings is available. This is the preferred method to produce graphics 

without blanked parts between single pings. If the scale factor is selected too big it is 

possible that still some blank pixels are visible on the plot. A function to remove such 

single pixels is selectable for that reason. 

The generation of mosaics means the combination of several single profiles within 

one output plot. A few different methods for the combination exist. When a pixel will 

be written to a position, where a pixel was already put before, they may be combined 

with the following options: the first pixel will be the final pixel, the last pixel will be the 

final pixel, the maximum amplitude will be used, the minimum amplitude will be used 

or an average of the amplitudes will be calculated. 
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The final picture can be smoothed with a gauss filter of a selectable strength to 

improve the signal to noise ratio and the quality of the output. 

Three overlay functions are available, first the drawing of the center line of the single 

profiles, second the drawing of a box with a fixed dimension around the center 

coordinate and third the drawing of grid lines, where the center coordinate is the 

center for the grid. The line distance is adjustable depending on the processed area. 
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The Data Output Dialog 

Finally the target directory, which is per default the data source directory, and the 

output file name have to be defined. To select another directory than the default a 

button to start a directory selection dialog is available. 

Optionally a geo-referenced picture will be created for every single profile, which was 

selected and for the final mosaic, or the mosaic only will be written to disk. The 

generation of a text files with reference coordinates of the output pictures will make 

the import into third party charting software more comfortable.  

By pressing the Button Start Side Scan Processor the processing will begin. The 

status bar of the software informs about the progress of the processing. Large data 

sets may require some time to finish. All of the dialogs are not accessible during the 

processing. 



ISE 2.9 User’s Guide     199

Innomar Technologie GmbH, October 2017 

Example of Output Graphic 

The following picture is a typical output of the Side Scan Processor Software. All 

options are enabled, like heading averaging, slant correction, TVG, pixel extension 

and smoothing. The grid line distance is 50 meters. 


